SIMPLIFIED WEB-BASED DECISION SUPPORT METHOD FOR TRAFFIC MANAGEMENT AND WORK ZONE ANALYSIS

Prepared For:
Utah Department of Transportation Research Division

Submitted By:
University of Utah Traffic Lab Department of Civil & Environmental Engineering

Authored by:
Xuesong Zhou
Milan Zlatkovic
Muhammad Farhan (WFRC)

Final Report - June 24, 2015
DISCLAIMER:

“The authors alone are responsible for the preparation and accuracy of the information. Data, analysis, discussions, recommendations, and conclusions presented herein. The contents do not necessarily reflect the views, opinions, endorsements, or policies of the Utah Department of Transportation and the US Department of Transportation. The Utah Department of Transportation makes no representation or warranty of any kind, and assumes no liability therefore.”
# Simplified Web-Based Decision Support Method for Traffic Management and Work Zone Analysis

Traffic congestion mitigation is one of the key challenges that transportation planners and operations engineers face when planning for construction and maintenance activities. There is a wide variety of approaches and methods that address work zone impacts, starting with simple equations, over spreadsheets and deterministic methods, to high-level computer simulation software. Some of the widely used tools include CA4PRS, QuickZone, and VISUM. However, every model has its own limitations and assumptions that are dictated by the applied computational technique. These analysis tools may not fully capture the dynamic nature of drivers' responses to traffic management techniques and significant changes in the transportation network. In this case, performing analyses with a Dynamic Traffic Assignment (DTA) engine, or a similar traffic estimation method, may meet this need while providing additional analysis details (e.g. network, path, OD, and link analyses) for local engineers to justify their decisions/actions. At the same time, technical expertise, data management, and software licensing often become significant barriers for incorporating this type of analysis into every-day operations. This research presents a DTA based tool that is designed to overcome the existing limitations in work zone simulation and analysis.

## Key Words
- Work zone, traffic congestion, web-based
TABLE OF CONTENTS

1. INTRODUCTION .......................................................................................................................... 1
2. LITERATURE REVIEW ................................................................................................................... 6
3. DEVELOPMENT OF A DATA HUB ................................................................................................. 9
4. DATA BRIDGE: REGIONAL NETWORK TO SUB NETWORKS ..................................................... 10
5. REGIONAL MPO PLANNING NETWORK ..................................................................................... 14
6. WORK ZONE SYSTEM DESIGN ................................................................................................... 16
   6.1 Work Zone Subarea Network ..................................................................................................... 18
   6.2 Methodology for Importing VISUM Subarea Network ............................................................. 19
   6.3 Work Zone Scenario Input/Output Data .................................................................................... 30
   6.4 Quick Estimation Method (QEM) Application for Signal Timing Estimation ....................... 32
   6.5 Web-Based User Interface ........................................................................................................ 44
7. SR 201 TEST CASE ...................................................................................................................... 47
   7.1 Network Validation ................................................................................................................... 48
   7.2 Results ...................................................................................................................................... 49

LIST OF TABLES

Table 7.1: Traffic Rerouting from SR 201 to Alternate Routes............................................................... 50
Table 7.2: Traffic Rerouting from Impacted Routes .............................................................................. 52
Table 7.3: Impacts on Signalized Intersections ................................................................................... 53

LIST OF FIGURES

Figure 1.1: Flow Process for Traffic Management Analysis and Work Zone Impact Estimation ........ 4
Figure 1.2: Data Flow and Communication ....................................................................................... 5
Figure 1.3: Basic Approach to Traffic Management and Work Zone Analysis Modeling Methodology .... 5
Figure 4.1: Data Hub Workflow and Backend Simulation Engine ..................................................... 11
Figure 5.1: Regional MPO Network in the Backend Simulation Engine .......................................... 15
Figure 6.1: Work Zone Test-Bed Network – Map and Backend Simulation Engine .......................... 16
Figure 6.2: Work Zone System Design ............................................................................................. 17
Figure 6.3: VISUM Regional Subarea Network for Work Zone Test-Bed ...................................... 20
Figure 6.4: Setting Map Projection System in VISUM ................................................................. 21
Figure 6.5: Exporting Shapefiles from VISUM ............................................................................. 22
Figure 6.6: Exporting Matrices from VISUM ................................................................................... 23
Figure 6.7: Exported Files in Destination Folder ............................................................................. 23
Figure 6.8: GIS Network Import Menu in NeXTA ........................................................................... 28
Figure 6.9: File Loading Status Window ......................................................................................... 28
EXECUTIVE SUMMARY

Traffic congestion mitigation is one of the key challenges that transportation planners and operations engineers face when planning for construction and maintenance activities. There is a wide variety of approaches and methods that address work zone impacts, starting with simple equations, over spreadsheets and deterministic methods, to high-level computer simulation software. Some of the widely used tools include CA4PRS, QuickZone, and VISUM. However, every model has its own limitations and assumptions that are dictated by the applied computational technique. These analysis tools may not fully capture the dynamic nature of drivers’ responses to traffic management techniques and significant changes in the transportation network. In this case, performing analyses with a Dynamic Traffic Assignment (DTA) engine, or a similar traffic estimation method, may meet this need while providing additional analysis details (e.g. network, path, OD, and link analyses) for local engineers to justify their decisions/actions. At the same time, technical expertise, data management, and software licensing often become significant barriers for incorporating this type of analysis into every-day operations.

The primary objective of this research project is to develop a simple, open source Google Maps/Google Earth interface for scenario-based traffic simulation analysis, primarily focused toward work zone analysis. Engineers may use the simplified interface and Spreadsheet methods to prepare different scenarios without interacting with the calibrated model input data, which are prepared by the local MPO. Input data are hosted online, and the simulation engine is offered as a web-application/service to simplify data preparation and improve computational efficiency.

Secondary objectives of this research project are to provide decision support methods for traffic engineers toward implementing online DTA for Advanced Travel Demand Management in daily practice. First, providing the traffic estimation tool as a backend computational engine can significantly shorten analysis time. Offering a simple user interface in a familiar software package like Google Maps or Google Earth makes it easier to perform this type of analysis, and their built-in visualization tools may be extremely useful for interpreting analysis results and preparing presentations/reports for decision-makers and stakeholders. Additionally, storing the
planning and traffic sensor data sets online reduces the time and effort spent preparing input data and requires less training for engineers using the software.

The developed tool has been tested on a hypothetical and a real-world network. These results show the ability of the developed tool to quickly perform before-after analysis for work zones, but also for any other events that have impacts on road capacities, whether freeways or arterials, such as adverse weather, incidents, special events and similar. The impacts can be assessed on multiple levels because of the successful integration of DTA, traffic flow models and a signal timing application. The web-based user interface allows the users to quickly assess the performance they need, and to represent the results in a visually appealing manner. The time needed to perform analysis and represent results with this tool is much shorter than creating separate models in different traffic simulation tools for different simulation levels. An added value is the existence of the underlying networks (such as the Regional MPO Planning Network), which can be quickly and easily transformed and used for any subarea. These features give the developed tool a significant advantage over other similar tools.
1. **INTRODUCTION**

Traffic congestion mitigation is one of the key challenges that transportation planners and operations engineers face when planning for construction and maintenance activities. There is a wide variety of approaches and methods that address work zone impacts, starting with simple equations, over spreadsheets and deterministic methods, to high-level computer simulation software. Some of the widely used tools include CA4PRS, QuickZone, and VISUM. However, every model has its own limitations and assumptions that are dictated by the applied computational technique. These analysis tools may not fully capture the dynamic nature of drivers’ responses to traffic management techniques and significant changes in the transportation network. In this case, performing analyses with a Dynamic Traffic Assignment (DTA) engine, or a similar traffic estimation method, may meet this need while providing additional analysis details (e.g. network, path, OD, and link analyses) for local engineers to justify their decisions/actions. At the same time, technical expertise, data management, and software licensing often become significant barriers for incorporating this type of analysis into every-day operations.

The main approach is shown in Figure 1.1. The users deal with the user-friendly GUI (Google Maps/Google Earth/NeXTA), while all the computation are performed by the backend simulation engine. All the data needed for analysis are obtained from the WFRC and hosted online, and the data are calibrated on the network-wide level (“data layer”). For any particular case, a subarea can be extricated through the GUI and sent to the simulation computational engine. The user provides following inputs through the GUI:

- Subarea
- Work zone characteristics
- MOEs to be analyzed
- Different scenario alternatives

The backend simulation engine is based on the integration of different modeling levels, to perform high-fidelity analysis of the various inputs and scenarios, and provide quality output results for decision making. The integration, data flow and basic approach are given in Figures
The users (“decision makers”) deal with the GUI, while all the data processing and calculation are performed independently.

The computational engine is able to accommodate a wide range of potential operations in response to a variety of recurring and non-recurring events, such as:

- Normal day-to-day operation
- Incident response: Incidents may occur on any facility in the network, however those resulting in temporary bottlenecks on freeways are difficult to accommodate on arterials, given the much larger lane capacity on freeways. The model must be able to accommodate a variety of operational features.
- Scheduled event: Similar to incident response but with the advantage of being able to plan in advance for it. The modeling needs are very similar to those for incidents. Work zones belong to the scheduled events. A special attention will be given to work zones over a time span of multiple days. The computational engine will be able to implement a day-to-day learning algorithm to count for the dynamic changes in traffic patterns during the road works.

To support the evaluation of traffic and work zone management strategies, the computational engine captures time-of-day congestion impacts by assigning time-dependent demand tables on a time-dependent network, and will consider the operational characteristics of the transportation network, so that system performance can be evaluated accurately to quantify the network performance changes in response to dynamic. The evaluation can be enhanced through the integrated framework, which allows traffic performance estimation and prediction, as well as the use of the real time data feeds.

Model integration is an essential part of the computational engine for several reasons:

- Analysis needs vary across spatial regimes. Transportation practitioners evaluate performance at the individual intersection, corridor, and network levels.
- Analysis needs vary across temporal regimes. Transportation practitioners evaluate performance for peak hour, multi-hour, entire day, multi-day, and whole year periods.
- Analysis needs vary in terms of their breadth and application type. Transportation practitioners evaluate the impact of land use and transportation decisions not just in terms of their effects on operational performance, but also on travel demand and behavior patterns, emissions, and freight movement.
Many traffic and work zone management strategies affect both transportation demand and supply concurrently. The analysis of strategies requires an understanding of the inter-relationship that exists between travel demand choices (departure mode, time, and path) on network performance and vice versa across multiple spatial and temporal regimes.

The primary objective of this research project is to develop a simple, open source Google Maps/Google Earth interface for scenario-based traffic simulation analysis, primarily focused toward work zone analysis. Engineers may use the simplified interface and Spreadsheet methods to prepare different scenarios without interacting with the calibrated model input data, which are prepared by the local MPO. Input data are hosted online, and the simulation engine is offered as a web-application/service to simplify data preparation and improve computational efficiency.

Secondary objectives of this research project are to provide decision support methods for traffic engineers toward implementing online DTA for Advanced Travel Demand Management in daily practice. First, providing the traffic estimation tool as a backend computational engine can significantly shorten analysis time. Offering a simple user interface in a familiar software package like Google Maps or Google Earth makes it easier to perform this type of analysis, and their built-in visualization tools may be extremely useful for interpreting analysis results and preparing presentations/reports for decision-makers and stakeholders. Additionally, storing the planning and traffic sensor data sets online reduces the time and effort spent preparing input data and requires less training for engineers using the software.
Figure 1.1: Flow Process for Traffic Management Analysis and Work Zone Impact Estimation
Figure 1.2: Data Flow and Communication

Figure 1.3: Basic Approach to Traffic Management and Work Zone Analysis Modeling Methodology
2. **LITERATURE REVIEW**

Literature describes a wide variety of approaches and methods for work zone analysis and estimating user costs. Ellis et al. (1) summarized six methods to calculate user costs: simple formulae, spreadsheets, high-level software, American Association of State Highway and Transportation Officials (AASHTO) red book method, flat rates and no formal method. Jiang et al. (2) developed a new microscopic computational model for estimating freeway work zone traffic delays and total work zone cost optimization using Boltzmann simulated annealing neural network and optimization techniques. However, it does not model the impact of detours. Chitturi et al. (3) have presented a numerical methodology based on equations for computing delays and user costs in highway work zones. Chien et al. (4) presented a simplified and useful model for estimating the delay cost using the AADT and finding the optimum work zone segment length in a four-lane freeway with one lane closure. Jiang et al. (5) developed a model for estimating the user costs at work zones. He showed that during congestion at work zones, delay costs of vehicle queues contributed to the total user costs. In an attempt to determine the user delay costs for typical Ontario work zones, Huen et al. (6) evaluated the significance of delays and associated delay costs for a construction zone using predetermined models. Results showed that the magnitude of delay is directly related to the volume of daily traffic and the number of lanes in the facility. Memmott et al. (7) studied the effects of different lane closures strategies (one-, two-, or three-lane closures) in one or both directions of travel and the additional costs to users traveling in a highway work zone. Their model, Queue and User Cost Evaluation of Work Zones, indicated that accuracy of cost calculations increases by using hourly instead of daily traffic volume. Saito et al. (8) compared four computer tools that determine user costs: MicroBENCOST, QuickZone, Delay-Enhanced, and Delay User Costs in a simple Excel spreadsheet. Saito et al. recommended that Delay User Costs in a simple Excel spreadsheet cost should be used for projects where the delay is caused by a reduction in speed while Delay-Enhanced should be used for projects where the source of delay stems from queues forming due to demand exceeding capacity. Najafi et al. (9) concludes that there is a need for user friendly software applicable to work zone evaluations. The literature shows that there is a wide variety of studies dealing with the evaluation of user costs related to work zones. Approaches vary from focusing exclusively on the work zone delay and user costs to evaluation by computer models.
Generally, most studies that deal with the estimation of user costs derive the magnitude of delay and user costs on freeway work zones using different computational models (1 - 7). However, every model has its own limitations and assumptions that are inherent to its computational technique. Studies on the evaluation of software tools show that different software packages work under specific conditions (8). Some of these models have no option to reduce the capacity on the links due to speed limit reduction. This study addresses these major gaps found in the models and methodologies used in previous studies.

There are several tools available for traffic engineers and planners that can be used for analyses of work zones. Some of the available tools are CA4PRS (which stands for Construction Analysis for Pavement Rehabilitation Strategies), QuickZone and VISUM. CA4PRS is one of the most widely used tools, which identifies optimal rehabilitation strategies that balance the construction schedule with inconvenience to drivers and transportation agency costs. It analyzes different scenarios and a variety of variables, such as the rehabilitation strategy, construction window, number of lanes closed, material selection, pavement base type, and contractor logistics. It also requires various attributes as inputs, including the number of lanes, speed limits before and during construction, vehicle operating costs, hourly traffic demands, and capacity adjustments. CA4PRS can also be integrated with traffic simulation tools to estimate road user delay costs arising from construction. At the end of day, CA4PRS quantifies the impact of construction work zone closures on the traveling public in terms of road user cost and time spent in queue. The disadvantages of CA4PRS are that it uses deterministic methods, which means it does not consider OD travel patterns and does not capture the dynamic nature of drivers’ responses to traffic management techniques and significant changes in the transportation network. Also, it requires that at least one lane is closed in the work zone area, and it is not able to capture impacts caused by speed reduction management strategies without lane closures in the work zone areas.

QuickZone is another analytical, Microsoft Excel spreadsheet based tool that estimates and quantifies work zone delays. It assigns travel demand on an hourly basis to estimate delay and queue length. It accommodates both time of the day utilization and seasonal variation in travel demand. The delay is estimated using a simple deterministic queuing model for each link in the
work zone impact area. The network in QuickZone can have up to 200 links and 100 nodes. Therefore, QuickZone’s network limitation restricts its ability to model detours. QuickZone requires several data inputs:

- Network data (nodes and links) and their attributes
- Annual Average Daily Traffic Data (AADT)
- Hourly truck traffic proportions
- Demand patterns
- Seasonal variations of the traffic demand
- Schedule of the project
- Cost parameters – Value of Travel (VOT)

QuickZone is also a deterministic, HCM-based analysis tool. It requires detailed link inputs and does not consider OD travel patterns and traffic dynamics. Possible solutions were found in its integration with macrosimulation planning tools, such as VISUM, which provides required inputs based on DTA assignments.

Some of the recognized limitations of these models are as follows:

- Require case-by-case data inputs from the user
- Use deterministic approaches and do not capture the nature of drivers’ responses to closures
- Cannot be applied to all cases
- Limitations in network size
- Do not assess user costs on detour routes and urban arterials
- Lack of visual representations of results
- Require from the users to be familiar with the software and have some knowledge of the computational engines

This study developed methods and tools that aim to overcome the limitations of the proposed tools. The users deal with the user-friendly GUI (Google Maps/Google Earth/NeXTA), while all the computation are performed by the backend simulation engine. All the data needed for analysis are hosted online and provided by the WFRC, and the data are calibrated on the network-wide level (“data layer”). For any particular case, a subarea can be extricated through the GUI and sent to the simulation computational engine.
3. DEVELOPMENT OF A DATA HUB

A multi-scale network editing and visualization tool is needed to integrate different simulation models across the full range of spatial and temporal resolutions. The data hub that is being developed for this project will have the ability to process and filter raw data from real-time sources including point, point-to-point and path measurements. Currently, many Radio Frequency Identification (RFID) RFID-based and Bluetooth-based Automatic Vehicle Identification (AVI) systems are widely deployed in real-time travel time estimation applications, while in-car navigation using the Global Positioning System (GPS) technology has matured into a rapidly growing industry and its penetration rate in the U.S. is expected to exceed 10% in 2010.

Visualization applied to multi-scale model integration is another emerging area of both research and practice. It is a critical component for both validating and reporting operational performance. The data hub should enable the visualization of input data and results as a central component.

For the purpose of testing the new methods and tools, the research team is developing an offline data hub that is using historical traffic data for work zone analysis. This data hub is based on the regional planning network obtained from WFRC that is currently being calibrated. In cooperation with UDOT, the research team will develop a set of test-case scenarios for testing and training purposes.
4. **DATA BRIDGE: REGIONAL NETWORK TO SUB NETWORKS**

All the analysis of work zone impacts is performed in the backend simulation engine. The user need to provide following inputs through the GUI:

- Subarea
- Work zone characteristics
- MOEs to be analyzed
- Different scenario alternatives

The backend simulation engine is based on the integration of different modeling levels, to perform high-fidelity analysis of the various inputs and scenarios, and provide quality output results for decision making. The integration, data flow and basic approach are given in Figures 4.1.
Figure 4.1: Data Hub Workflow and Backend Simulation Engine

The computational engine is able to accommodate a wide range of potential operations in response to a variety of recurring and non-recurring events, such as:

- Normal day-to-day operation
- Incident response: Incidents may occur on any facility in the network, however those resulting in temporary bottlenecks on freeways are difficult to accommodate on arterials, given the much larger lane capacity on freeways. The model must be able to accommodate a variety of operational features.
- Scheduled event: Similar to incident response but with the advantage of being able to plan in advance for it. The modeling needs are very similar to those for incidents. Work zones belong to the scheduled events. A special attention will be given to work zones
over a time span of multiple days. The computational engine is able to implement a day-to-day learning algorithm to count for the dynamic changes in traffic patterns during the road works.

To support the evaluation of traffic and work zone management strategies, the computational engine captures time-of-day congestion impacts by assigning time-dependent demand tables on a time-dependent network, and considers the operational characteristics of the transportation network, so that system performance can be evaluated accurately to quantify the network performance changes in response to dynamic. The evaluation can be enhanced through the proposed integrated framework, which allows traffic performance estimation and prediction, as well as the use of the real time data feeds.

Model integration is an essential part of the computational engine for several reasons:

- Analysis needs vary across spatial regimes. Transportation practitioners evaluate performance at the individual intersection, corridor, and network levels.
- Analysis needs vary across temporal regimes. Transportation practitioners evaluate performance for peak hour, multi-hour, entire day, multi-day, and whole year periods.
- Analysis needs vary in terms of their breadth and application type. Transportation practitioners evaluate the impact of land use and transportation decisions not just in terms of their effects on operational performance, but also on travel demand and behavior patterns, emissions, and freight movement.
- Many traffic and work zone management strategies affect both transportation demand and supply concurrently. The analysis of strategies requires an understanding of the inter-relationship that exists between travel demand choices (departure mode, time, and path) on network performance and vice versa across multiple spatial and temporal regimes.

In additional, the user interface allows interactive visual analysis for traffic strategy evaluation. Particularly, a user is able to (1) click on the Google Earth map to layout or identify the type of the impacts or restrictions to the roadway(s); and (2) analyze small or localized impact based on visualization results through Google Earth or Google Maps. With a clear representation of parameters related to traffic impact, the developed tool visualizes analysis results for a selected network area on the Google Earth map quickly, as well as traffic impact data results.

The computational engine can also analyze work zone impacts on arterial networks. Through DTA, the engine is able to calculate the amount of traffic diverted to the arterial network, caused
by the capacity reduction in the work zone area. Once the amount of additional traffic on arterials is computed, the engine can estimate increase in delays on arterial streets and signalized intersection. The Quick Estimation Method (QEM) Excel spreadsheet is integrated with the simulation engine and it represent a computational engine for estimating signalized intersections operation. It implements the HCM 2010 methodology for signalized intersection analysis and the HCM QEM method, and other methodologies for computing parameters of signalized intersections (as described in the current Signal Timing Manual). It is using on-the-fly estimation of signal timing parameters for signalized intersections, and provides more realistic intersection capacities than those estimated in current meso-simulation software packages. This allows for an integrated approach in estimating work zone induced delays and user costs on the freeway and arterial network. It also provides a quick bridge to signalized intersections analysis software, such as Synchro, further helping traffic engineers to quickly perform signal timing optimization for new traffic demand.
5. REGIONAL MPO PLANNING NETWORK

The research team has obtained the latest regional MPO planning network for developing the offline data hub, computational engines, GUI, and test-case scenarios. This network is calibrated based on the most recent traffic data.

The regional MPO network consists of 2250 TA zones, close to 14,000 nodes and 27,000 links. The current OD demand and node-link structure is converted to the backend simulation engine NeXTA, and is used in further data hub development and analysis. The regional network is the starting point in work zone analysis and contained in the backend computational engine. Any subarea of the regional network can be extracted and calibrated based on real time traffic data. Subareas can be used for detailed analysis of freeway and arterial sub networks impacted by work zones. Figure 5.1 shows the regional MPO network prepared for the backend simulation engine.

The calibration of any sub-network will depend on its size, available data, as well as the result requirements (i.e. how detailed the results should be). The data used for calibration usually consist of traffic volumes, travel times and speeds. These data can be obtained through UDOT’s online systems, such as PeMS data for freeways, or Signal Performance Metrics data for arterials. The calibration can partially be performed using NeXTA’s ODME (Origin-Destination Matrix Estimation) tool, and through manual adjustments. The network developed and calibrated for the SR 201 test case, described in Section 7, can represent a good starting point for any sub-network analysis within the Salt Lake County, since it includes all the major freeways, arterials and signalized intersections with all the correct geometry.
Figure 5.1: Regional MPO Network in the Backend Simulation Engine
6. **WORK ZONE SYSTEM DESIGN**

For the purpose of testing the new methods and tools, the research team developed an offline data hub that is using historical traffic data for work zone analysis. This data hub is based on the regional planning network obtained from WFRC and calibrated. The research team has developed test-case scenarios for testing purposes, and the procedures and results are presented in Appendix 3 and Appendix 4.

Figure 6.1 shows the general area for the work zone test-bed. The research team has selected a segment of I-15 in Salt Lake County, between I-80 and I-215 interchanges. The analysis focuses on the freeway and arterial traffic under different work zone scenarios.

![Figure 6.1: Work Zone Test-Bed Network – Map and Backend Simulation Engine](image)

All the analysis of work zone impacts will be performed in the backend simulation engine. The user will need to provide following inputs through the GUI:

- Subarea
- Work zone characteristics
- MOEs to be analyzed
- Different scenario alternatives
The backend simulation engine is based on the integration of different modeling levels, to perform high-fidelity analysis of the various inputs and scenarios, and provide quality output results for decision making. The work zone system design used in the test-bed is given in Figure 6.2.

To support the evaluation of traffic and work zone management strategies, the computational engine captures time-of-day congestion impacts by assigning time-dependent demand tables on a time-dependent network, and considers the operational characteristics of the transportation network, so that system performance can be evaluated accurately to quantify the network performance changes in response to traffic dynamics.

The computational engine can also analyze work zone impacts on arterial networks. Through DTA, the engine is able to calculate the amount of traffic diverted to the arterial network, caused by the capacity reduction in the work zone area. Once the amount of additional traffic on arterials is computed, the engine can estimate increase in delays on arterial streets and signalized intersection. The Quick Estimation Method (QEM) Excel spreadsheet is integrated with the
simulation engine and it represent a computational engine for estimating signalized intersections operation. It will rely on the HCM 2010 methodology for signalized intersection analysis and the HCM QEM method, and other methodologies for computing parameters of signalized intersections (as described in the current Signal Timing Manual). It is using on-the-fly estimation of signal timing parameters for signalized intersections, and provides more realistic intersection capacities than those estimated in current meso-simulation software packages. This allows for an integrated approach in estimating work zone induced delays and user costs on the freeway and arterial network. It also provides a quick bridge to signalized intersections analysis software, such as Synchro, further helping traffic engineers to quickly perform signal timing optimization for new traffic demand.

The key components of the work zone system design are as follows:

1. Cloud computing/Google Earth based architecture (see Appendix 1)
2. Work zone subarea network (See Appendix 2 on calibrating work zone capacity)
3. Work zone scenario input/output data
4. Dynamic traffic assignment (DTA)
5. Quick Estimation Method (QEM) application for signal timing estimation
6. Freeway HCM capacity analysis application FREEVAL
7. User interface

6.1 Work Zone Subarea Network

The detailed geometry of the subarea network that is used as the test-bed for work zone impact analysis contained in the backend simulation engine, showed in Figure 6.1, is obtained from the detailed VISUM regional network model. The subarea has first been extracted in VISUM from the regional network, and then converted into the NeXTA model that serves as the backend simulation engine and the cross-resolution modeling data hub. This section describes the detailed, step-by-step procedure for importing the VISUM network into the NeXTA cross-resolution modeling data hub.
6.2 Methodology for Importing VISUM Subarea Network

NeXTA’s network conversion tool specifically imports network data from shapefiles, which are geospatial vector data files used with Geographic Information System (GIS) software and commonly supported by many transportation modeling software packages. Shapefiles contain spatial information about points, lines, and polygons in the transportation network, with separate files for different shapes. Road networks are represented as a graph of links (lines) and nodes (points), where links may represent road segments or transit lines and nodes may represent intersections or connections between individual links, and trips are often made between zones (polygons) on the network.

Network attribute data is stored in database (DBF) files for each shapefile, which must be read by NeXTA during the conversion process. Network data formatting is very flexible between network modeling software packages, with many applications allowing users to define custom formats and data fields for use within a software package. To support these applications, NeXTA uses a configuration CSV file for importing GIS settings, to identify and connect the fields in the input DBF files to their corresponding fields in the NeXTA/DTALite data format (import_GIS_settings.csv). All input shapefiles must have the same map projection before using the conversion tool. NeXTA currently supports one map projection – WGS84, the default projection for Google Earth and the KML data standard. Map projection data is stored in a projection (PRJ) file within the shapefile standard.

The conversion tools offer the ability to convert networks for modeling at different spatial and temporal resolutions. The methodology for maintaining network and input data integrity between network models is detailed below.

Step 1: Export network and demand data from VISUM
Step 2: Import network into NeXTA
Step 3: Import demand data
Step 4: Run assignment with DTALite to equilibrium
Step 1: Export network and demand data from VISUM

The first step in the network conversion process is to create a set of shapefiles describing the network to be imported into NeXTA. This is normally accomplished using export functions in the software used to prepare the selected network, and can be divided into three internal steps:

1. Load the network in originating software application
2. Export network as shapefiles
3. Export demand tables/matrices

1) Load the network in VISUM

In this example, the regional subarea network was coded in VISUM and must be exported as a set of shapefiles. First, the network is loaded in VISUM, which is shown in Figure 6.3.

![VISUM Regional Subarea Network for Work Zone Test-Bed](image)

Figure 6.3: VISUM Regional Subarea Network for Work Zone Test-Bed

Once the network is loaded in VISUM, it is recommended to check the map projections system and set it to WGS84 if some other system is used. In VISUM, this can be done by setting Network Parameters. In the Menu toolbar, go to Network → Network Parameters…, select the Scale tab and check the Spatial reference system. Make sure that the From file option is checked,
and that the reference system is set to GCS_WGS_1984. This procedure is shown in Figure 6.4. If the projection system is not changed in this step, the user must manipulate the shapefiles exported from VISUM in third-party software.

Figure 6.4: Setting Map Projection System in VISUM

2) Export network as shapefiles

By using VISUM’s export function (File → Export → Shapefile), the network is split into its components, and saved as multiple separate shapefiles. First the user selects the destination folder for the network, gives the base name of the exported files under the File name (e.g. WZ_subarea), and VISUM automatically adds suffix names for each layer. After pressing the Save button, VISUM opens another window where the user can choose which layers to export. In this example we select the node, link, zone, zone centroid, and connector layers to ensure that the conversion process can successfully create a new network. VISUM will export the shapefiles in the previously defined projection system. Once finished selecting export options, select “OK” at the bottom of the dialog box. This procedure is given in Figure 6.5.
3) Export demand tables/matrices

Click on the Matrices tab in the Overview toolbar to display the demand matrices. The zone matrices are compatible with the demand definition in NeXTA, so they are the main focus of this effort. Right click on the desired matrix, select Save to File…, navigate to the destination folder, give the name to the matrix, select Save, and in the next window select Format O from the Format dropdown list. Format O is a common 3-column format that can be easily read by NeXTA. NeXTA also supports the standard VISUM “Format V” demand matrix format, which takes the form of a table with size Origin x Destination. This matrix exporting procedure is shown in Figure 6.6.
The shapefiles and the matrix are now placed in the destination folder, which contains the following files:

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>WZ_subarea_connector.CTF</td>
<td>3/4/2003 11:01 AM</td>
<td>CTF File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_connector.DBF</td>
<td>3/4/2003 11:01 AM</td>
<td>DBF File</td>
<td>18 KB</td>
</tr>
<tr>
<td>WZ_subarea_connector.PRI</td>
<td>3/4/2003 11:01 AM</td>
<td>PRI File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_connector.SHP</td>
<td>3/4/2003 11:01 AM</td>
<td>SHP File</td>
<td>21 KB</td>
</tr>
<tr>
<td>WZ_subarea_connector.SHX</td>
<td>3/4/2003 11:01 AM</td>
<td>SHX File</td>
<td>2 KB</td>
</tr>
<tr>
<td>WZ_subarea_link.CTF</td>
<td>3/4/2003 11:01 AM</td>
<td>CTF File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_link.DBF</td>
<td>3/4/2003 11:01 AM</td>
<td>DBF File</td>
<td>128 KB</td>
</tr>
<tr>
<td>WZ_subarea_link.PRI</td>
<td>3/4/2003 11:01 AM</td>
<td>PRI File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_link.SHP</td>
<td>3/4/2003 11:01 AM</td>
<td>SHP File</td>
<td>192 KB</td>
</tr>
<tr>
<td>WZ_subarea_link.SHX</td>
<td>3/4/2003 11:01 AM</td>
<td>SHX File</td>
<td>18 KB</td>
</tr>
<tr>
<td>WZ_subarea_node.CTF</td>
<td>3/4/2003 11:01 AM</td>
<td>CTF File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_node.DBF</td>
<td>3/4/2003 11:01 AM</td>
<td>DBF File</td>
<td>29 KB</td>
</tr>
<tr>
<td>WZ_subarea_node.PRI</td>
<td>3/4/2003 11:01 AM</td>
<td>PRI File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_node.SHP</td>
<td>3/4/2003 11:01 AM</td>
<td>SHP File</td>
<td>8 KB</td>
</tr>
<tr>
<td>WZ_subarea_node.SHX</td>
<td>3/4/2003 11:01 AM</td>
<td>SHX File</td>
<td>26 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone.CTF</td>
<td>3/4/2003 11:01 AM</td>
<td>CTF File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone.DBF</td>
<td>3/4/2003 11:01 AM</td>
<td>DBF File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone.PRI</td>
<td>3/4/2003 11:01 AM</td>
<td>PRI File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone.SHP</td>
<td>3/4/2003 11:01 AM</td>
<td>SHP File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone.SHX</td>
<td>3/4/2003 11:01 AM</td>
<td>SHX File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone_centroid.CTF</td>
<td>3/4/2003 11:01 AM</td>
<td>CTF File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone_centroid.DBF</td>
<td>3/4/2003 11:01 AM</td>
<td>DBF File</td>
<td>8 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone_centroid.PRI</td>
<td>3/4/2003 11:01 AM</td>
<td>PRI File</td>
<td>1 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone_centroid.SHP</td>
<td>3/4/2003 11:01 AM</td>
<td>SHP File</td>
<td>5 KB</td>
</tr>
<tr>
<td>WZ_subarea_zone_centroid.SHX</td>
<td>3/4/2003 11:01 AM</td>
<td>SHX File</td>
<td>2 KB</td>
</tr>
</tbody>
</table>
Step 2: Import network into NeXTA

The second step in the network conversion process is to use NeXTA’s network import tool to convert the shapefiles (created in the previous step) into a network which can be used with NeXTA and DTALite. This process reads the spatial data stored in each specified shapefile, along with the corresponding data stored in the database (DBF) file, to create the input CSV files used by NeXTA and DTALite. In order to interpret the database (DBF) files for conversion, a GIS configuration CSV file is used to map field names between the shapefiles and the standard data format used by NeXTA (import_GIS_settings.csv).

The network import process is divided into three internal steps:

1. Prepare the configuration file for conversion
2. Use NeXTA’s import network tool to convert the network
3. Save the new network as a new project file

1) Prepare the configuration file for conversion

First, we create a configuration file in the folder containing the exported shapefiles (import_GIS_settings.csv). The configuration file consists of several sections, as defined in Column A. The “key” settings given in Column B are used by NeXTA to successfully match and convert the shapefiles from the DBF files. “Value” in Column C is the matching name between NeXTA’s “key” values, and those given in the shapefiles. When used with VISUM, these values are read from the corresponding lists accesses in VISUM through Menu → Lists, or the converted shapefiles can be opened in any GIS software and accessed through attribute tables. “Allowed_values” in Column D show which definitions are related to “value” for binary values (such as km vs. mile, lane vs. link, etc). Column E (“required”) shows which values must be defined for a successful import.

The first section defines the shape filenames for nodes, links, zones, centroids, and connectors. The reference file names should correspond to the layers exported from VISUM. In this case, the file names have the format WZ_subarea _(layer).shp. Node and link are the required layers for a successful GIS network import. The file name table contains the following inputs:
The next section defines configuration settings. These settings include the latitude/longitude coordinate system definition, length units, one way vs. two way links, and whether the capacity is given per lane, or per link. In this case, the configuration settings are as follows:

<table>
<thead>
<tr>
<th>section</th>
<th>key</th>
<th>value</th>
<th>allowed_values</th>
<th>required</th>
</tr>
</thead>
<tbody>
<tr>
<td>configuration</td>
<td>with_decimal_long_lat</td>
<td>yes</td>
<td>yes;no</td>
<td></td>
</tr>
<tr>
<td>configuration</td>
<td>length_unit</td>
<td>mile</td>
<td>km;mile</td>
<td></td>
</tr>
<tr>
<td>configuration</td>
<td>number_of_lanes_oneway_vs_twoway</td>
<td>oneway</td>
<td>oneway;twoway</td>
<td></td>
</tr>
<tr>
<td>configuration</td>
<td>lane_capacity_vs_link_capacity</td>
<td>lane</td>
<td>lane;link</td>
<td></td>
</tr>
</tbody>
</table>

The next section defines node attributes. The import values are node ID, node name, the zone (TAZ) to which a certain node belongs to, and node control type. These values can be read directly in VISUM, or the corresponding shapefile can be opened in any GIS software, and the values read from the attribute table. The node table in this case contains the following:

<table>
<thead>
<tr>
<th>section</th>
<th>key</th>
<th>value</th>
<th>allowed_values</th>
<th>required</th>
</tr>
</thead>
<tbody>
<tr>
<td>node</td>
<td>node_id</td>
<td>NO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>node</td>
<td>name</td>
<td>NAME</td>
<td></td>
<td></td>
</tr>
<tr>
<td>node</td>
<td>TAZ</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>node</td>
<td>control_type</td>
<td>CONTROLT~1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The following section defines the link shapefile attributes. In order to code the corresponding attributes correctly, the user needs to open the link list in VISUM (Menu → Lists → Links), or access the link shapefile through GIS software, and read the link attributes. The available link attributes are from and to node, name, link ID, link type, transportation modes that link is open for, direction definition, number of lanes, hourly capacity, speed limit, and number of lanes, capacity, speed limit and link type for reversible lanes, if links are defined as two way links. There is a separate CSV file for link types (input_link_type.csv) that IS updated with the correct link types exported from VISUM. The link table is as follows:

<table>
<thead>
<tr>
<th>section</th>
<th>key</th>
<th>value</th>
<th>allowed_values</th>
<th>required</th>
</tr>
</thead>
<tbody>
<tr>
<td>link</td>
<td>from_node_id</td>
<td>FROMNODENO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>to_node_id</td>
<td>TONODENO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>name</td>
<td>NAME</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>link_id</td>
<td>NO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>link_type</td>
<td>TYPENO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>mode_code</td>
<td>TSYSSSET</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>direction</td>
<td>ISFORWARD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>length</td>
<td>LENGTH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>number_of_lanes</td>
<td>NUMLANES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>hourly_capacity</td>
<td>CAPPRT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>speed_limit</td>
<td>V0PRT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>r_number_of_lanes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>r_hourly_capacity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>r_speed_limit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>link</td>
<td>r_link_type</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The next section is the zone table. The settings for the zone attributes are similar as for nodes and links, with the only important attribute being zone ID. The correct ID name is read from the zone link list in VISUM, or through the attribute table in GIS software:
The corresponding codes for centroid and connector layers are read from the connector and zone lists in VISUM, or through the attribute table in GIS software. The definitions for centroids are name, node ID, and zone (TAZ). The definitions for connectors are zone end, link end, node end, length, number of lanes, hourly capacity, default speed limit, default link type, and direction.

2) Use NeXTA’s import network tool to convert the network
Starting with a new, empty network project in NeXTA, the conversion process is initiated by selecting the appropriate tool in the Import Menu, which can be found under File → Import →
GIS Network Data Set. A pop-up dialog box provides information about the importing configuration and required CSV files. This step is shown in Figure 6.8.

![Image: GIS Network Import Menu in NeXTA](image1)

**Figure 6.8: GIS Network Import Menu in NeXTA**

After the conversion process is complete, a File Loading Status window opens to display the results of the conversion process, as given in Figure 6.9.

![Image: File Loading Status Window](image2)

**Figure 6.9: File Loading Status Window**

The imported sub-network for work zone test-bed is shown in Figure 6.10.
Step 3: Import demand data from regional travel demand model

The demand matrices from VISUM are exported in Format O, which is a typical 3-column format for zone-to-zone demand. The demand data settings are defined in the input_demand_meta_data.csv file in the project folder. In this CSV file, among other settings, the user defines the scenario to which the demand is applied, the file sequence if there are more than one demand data table/matrix, the format type, number of lines to be skipped, loading multiplier, simulation start and end times, and different demand types. Note that these settings can be accessed and changed directly within NeXTA, through Menu → Project → 2. Demand Meta Database. The demand matrices can be used in the exported .mtx file, or converted to a .csv file input_demand.csv.

Step 4: Run assignment with DTALite to equilibrium
After all network and demand data are imported, the network is ready for running DTA. The simulation is run by pressing the button located in the toolbar menu. The popup window that appears shows the defined settings, and allows a selection of the traffic flow model, traffic assignment method, the number of iterations, and the demand loading multiplier, as shown in Figure 6.11.

![Simulation/Assignment Settings Window](image)

**Figure 6.11: Simulation/Assignment Settings Window**

### 6.3 Work Zone Scenario Input/Output Data

Work zones along urban freeways can have significant impacts on both the freeway, and the adjacent arterial networks. All available software for work zone analysis relies on similar input data, and provides similar outputs on work zone impacts. However, they mostly assess impacts on the freeway network, and have no ability to estimate impacts along the urban arterials. Also, there are limitations in the network size that can be included, they do not capture drivers’ responses to closures, cannot be applied to all cases (for example, if only speed is impacted by the work zone, and not capacity), and they require case-by-case data inputs from the user.

The proposed work zone system design can overcome these shortcomings of the existing software, and provide a user-friendly GUI for easy communication with the user. The main inputs needed for this methodology are as follows:
• Freeway network geometry and lane capacity information
• Freeway speed limits
• OD demand patterns
• Freeway hourly traffic volumes
• Freeway proportions of heavy vehicles
• Value of time (VOT) for different vehicle types
• Toll information
• Work zone information: location, duration with start and end times, capacity reduction, speed limit, prohibition for some vehicle types, management of HOV/HOT lanes within the work zone, closure of freeway ramps in the vicinity, etc.
• Arterial network geometry and lane capacity information
• Arterial speed limits
• Arterial street and intersection closures
• Arterial hourly volumes
• Signalized intersections locations
• Signalized intersections geometry

The backend simulation engine, and the supporting applications for freeway and intersection analysis, uses all the inputs to provide the user with detailed results of the work zone impacts on the freeway and arterial network levels. The main outputs from the work zone system design are as follows:

• Redistribution of traffic between freeway and arterial networks in the impacted zones through DTA
• Delays, travel times, speeds, LOS and user costs for freeways and arterials
• Detailed freeway capacity analysis through FREEVAL application
• Detailed signalized intersection capacity analysis through QEM application
• Convenient 3D visualization of any selected results
6.4 Quick Estimation Method (QEM) Application for Signal Timing Estimation

One of the biggest challenges in meso and macrosimulation is the estimation of signalized intersection capacities. These simulation tools lack a good signal control emulator that would provide realistic signal timing and phasing data, and simplify the exporting process of signalized intersections. Almost all signal timing adjustments had to be set manually once they are exported from meso/macrosimulation to microsimulation, or Synchro-like software. For existing networks, this process can somewhat be simplified by importing field traffic control data, but it becomes more complex for predicted and estimated traffic conditions, when the field data are not available. Therefore, the development of a tool for quick estimation of signal timings is an important step in simplifying the cross resolution modeling efforts. The QEM_SIG Excel spreadsheet that accompanies the NeXTA software represents a computational engine for estimating signalized intersections operation. It is relying on the HCM 2010 methodology for signalized intersection analysis and the HCM QEM method, but it is also using other methodologies for computing parameters of signalized intersections (as described in the Signal Timing Manual (STM), 2008 edition). It can be used as a stand-alone application, or integrated with NeXTA. The latest edition of the stand-alone application is a macro-enabled workbook, with the options to export Synchro CSV files and create signalized intersection analysis reports in the PDF format for a more convenient representation of results.

Figure 6.12 shows the input/output configuration, while Figure 6.13 shows the data flow of the QEM application.
Figure 6.12: QEM Input/Output Configuration

**Inputs**
- General Traffic Data (PHF, HOV%, S0, etc.)
- Street Names
- Intersection Geometry
- Traffic Movement Volume Counts (1 hr)
- Approach Speeds
- Presence of Pedestrians
- Right-Turn-on-Red (RTOR) Percentage
- Manual or Automatic Left Turn Treatment

**QEM Calculation Engine**

**Outputs**
- Signal Phases and Ring-BARRIER Structure
- Left Turn Treatment (if not set manually)
- Lane Group Flows
- Cycle Length
- Phase Splits, Green and Clearance Times
- Movement Capacities, V/C Ratios, Delays, LOS
- Intersection MOEs (Delay, LOS, V/C, Status)
- Signal Phasing Data

Figure 6.13: QEM Data Flow
6.4.1 Methodology

The methodology of the QEM application is given by sections, and they are defined as follows (different tabs in the spreadsheet):

- **Sheet 1** – input/output sheet for communication with NeXTA
- **Input sheet** – data input section; this is the only section where the user needs to input intersection data if the spreadsheet is used as a stand-alone application
- **Phase designation** – assigning phases to intersection movements, determining left turn treatment and defining ring-barrier structure
- **Lane volumes** – calculation of lane volumes (HCM 2010 Chapter 31)
- **Phase calculation** – calculation of the cycle length, green time (splits) allocations, movement capacities, V/C ratios, and Levels of Service (LOS)
- **Phasing** – calculate phasing data for correct export to Synchro
- **Summary sheet** – output sheet with calculation results

**Sheet 1** communicates with NeXTA during mesosimulation, and it reads and writes signal control data. For each intersection in the simulation, Sheet 1 reads lane configurations, turning volumes, and main movement speeds, and uses them in the calculation procedure. Then it returns data for phase designation (that includes protected/permitted phases for left turns), detector phases, effective green, capacity, V/C ratio, delay, LOS, and the complete array of phasing data. NeXTA can further use these outputs to export traffic data in the UTDF format for use with Synchro or VISSIM. When the QEM spreadsheet is used as a stand-alone application, Sheet 1 must not be deleted nor amended, since it actively communicates with other sections. It does not provide outputs in a user-friendly format, but these outputs can be used to manually export lanes/volumes/phasing/timing data to Synchro. The look of Sheet 1 is shown in Figure 6.14.
Figure 6.14: The Layout of Sheet 1

The Input sheet is the only section where the user is asked to enter intersection data. This sheet is important if the QEM is used as a stand-alone application, although some inputs are required for NeXTA integration. The following inputs are needed:

- Street names – optional.
- Intersection lane configuration – required (number of lanes for each approach and each movement).
- Turning volumes for each movement – required.
- Right Turn on Red (RTOR %) – required. The estimated values for this entry are 50-75% for exclusive right turn lanes, and less than 10% for shared.
- Approach through speeds – important if these speeds are greater than 45 mph, since this is one of the requirements for protected only left turn treatments. Also needed for correct calculation of phasing data.
• Presence of pedestrians – select option (Yes/No) from the drop-down menu. If pedestrians are present, pedestrian timing will be included in minimum splits and cycle calculation. For urban intersection, this option should generally be enabled. If QEM is used with the NeXTA software, this option can be set only once, and it will be the same for all intersection that NeXTA is estimating.

• Manual selection of left turn treatment – if used as a stand-alone version and field data regarding left turn treatment are known, this entry allows for a manual selection of left turn treatment. If activated, this option will allow left turn treatment for each approach to be selected from the drop-down menu. The options are: Protected, Permitted, Protected + permitted, or blank. This entry will override the automatic designation of left turn treatments.

**Note:** if used with NeXTA, this option should be disabled. Also, if for some approaches the selection is not defined (“blank”), left turns for that approach will be assigned automatically.

The following set of data should be defined when the QEM spreadsheet is used either with NeXTA, or a stand-alone application:

• Ideal saturation flow rate – by default, this value is 1900 vphpl. Can be changed to reflect calibrated saturation flow rate for local conditions.

• Peak Hour Factor (PHF) – if known, it can be entered in this field. Otherwise, it can be set to the value of 0.9.

• Percentage of heavy vehicles (HGV %) – if known, it can be entered in this field. Otherwise, the default value can be set to 3%.

• Lost time per phase (s) – by default, this value is 4 seconds. Can be changed to reflect calibrated lost time for local conditions.

• Area Type – the drop down menu in this field offers a selection between “CBD” (Central business district) and “Other”. Area Type should be selected for the analyzed network.

• Minimum and maximum cycle length inputs – allows the user to define these values for local conditions. By default, the minimum cycle length is 40 seconds, and maximum is 150 seconds.

The Input Sheet in the stand-alone application also contains two action buttons, Synchro CSV Export, and Generate QEM Report. The Synchro CSV Export creates the five CSV files for direct import into Synchro (LAYOUT, LANES, VOLUME, PHASING and TIMING). These files are written into the same folder where the QEM spreadsheet is located. The Generate QEM Report creates a signalized intersection analysis report in the PDF format for a more convenient
reporting of results. The PDF report is directly saved into the same folder where the QEM spreadsheet is located with a filename “Intersection ‘NAME OF INTERSECTION’ QEM Report”. The name of the intersection is automatically taken from the street names defined in the Input Sheet. The QEM report has a similar format as the corresponding report obtained from Synchro.

After the input values are defined, the user should not change any other values in other sheets. Figure 6.15 shows the layout of the Input sheet.

![Figure 6.15: The Layout of the Input Sheet](image)

The **Phase designation** sheet determines the major street (NS or EW), defines phases for each movement, and determines the left turn treatment based on the criteria defined in the HCM and STM (Protected only, Permitted only, or Protected + permitted). If the left turn treatment is manually selected in the Input sheet, this selection will be implemented, and the automatic designation overridden. In the case of a 3-leg intersection, the left turn is treated as permitted (the through phase is shown). For phase numbering, the Utah Department of Transportation (UDOT) standard is used: if NS is the major movement, the NB through movement is phase 2; if EW is the major movement, the WB through movement is phase 2. Once the phases and left turn treatments are known, the program defines the standard dual ring-barrier structure for the given
The Phase designation sheet is shown in Figure 6.16.

![Phase Designation Sheet](image)

**Figure 6.16: Phase Designation Sheet**

The **Lane volumes** sheet calculates critical lane volumes for each intersection approach. It follows the methodology defined in the HCM 2010, Chapter 31. The computed lane volumes are later used in cycle length calculation. This sheet is shown in Figure 6.17.
The **Phase calculation** sheet, shown in Figure 6.18, performs calculations of all signal control parameters. It is using inputs defined by the user/NeXTA, and outputs from the previous steps. The critical movement methodology is used in cycle length calculations. The cycle length calculation is limited to 10 second increments, in the default range between 40 seconds (Cmin) and 150 seconds (Cmax), or in the range defined by the user. The following steps is implemented in parameters calculation:

1. Calculate cycle length and initial phase splits based on the HCM methodology.
2. The corresponding splits (green time + exchange interval) are assigned to each phase in the ring-barrier structure.
3. The splits are recalculated for each phase based on the cycle length and the critical ring split summation.
4. The splits are recalculated again for each barrier, following the critical barrier split summation. This step ensures the simultaneous barrier crossing and prevents phase conflicts.

5. The calculated splits are compared to the minimum splits (see Phasing), and are reassigned if necessary.

6. When the phase splits are known, the HCM procedure is followed to calculate movement capacities, V/C ratios, control delays and LOS.

This section goes beyond the typical QE methodology, since it gives realistic signal timing parameters common in all North American ring-barrier controllers. This is especially significant for a fast conversion process used in cross-resolution.

Figure 6.18: Phase Calculation Sheet
The **Phasing sheet**, given in Figure 6.19, calculates all the phasing data required by Synchro for an error-free analysis. It is using default tables from the STM for different parameters. The parameters calculated in this sheet are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Minimum green</th>
<th>Minimum phase recall</th>
<th>Phase end time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum green</td>
<td>Walk time</td>
<td>Phase yield time</td>
<td></td>
</tr>
<tr>
<td>Vehicle extension</td>
<td>Don’t walk time</td>
<td>Phase yield for type 170 controllers</td>
<td></td>
</tr>
<tr>
<td>Time before reduce</td>
<td>Pedestrian recalls</td>
<td>Local start time</td>
<td></td>
</tr>
<tr>
<td>Time to reduce</td>
<td>Minimum split</td>
<td>Local yield time</td>
<td></td>
</tr>
<tr>
<td>Minimum gap</td>
<td>Dual entry</td>
<td>Local yield time for type 170 controllers</td>
<td></td>
</tr>
<tr>
<td>Yellow time</td>
<td>Max time call inhibition</td>
<td></td>
<td></td>
</tr>
<tr>
<td>All red time</td>
<td>Phase start time</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Figure 6.19: Phasing Sheet](image-url)
The Summary sheet (see Figure 6.20) gives all the main outputs from previous steps in a user-friendly graphical representation. The following parameters are shown:

- Turning volumes (vph)
- Phase designations
- Number of lanes for each movement
- Split durations (s)
- Movement capacities (vph)
- V/C ratios
- Control delays (s)
- Intersection LOS
- Summary table

Figure 6.20: Summary Sheet
6.4.2 Using QEM in NeXTA

The QEM application is fully integrated with NeXTA. It performs on-the-fly signal parameters estimation using turning volumes obtained through NeXTA/DTALite simulation. The current running speed is about one signalized intersection per second, and it can handle any number of signalized intersections in the given network. The estimated signal timing parameters are placed into a separate QEM_Log file, and they are used for exporting to Synchro or other software. All the signal timing and phasing data are provided in the UTDF format, which enables exchange among different traffic software applications.

The accompanying QEM_SIG.xls file needs to be copied to the NeXTA’s home folder. This is a separate version of the QEM application that does not contain macros. In the Input Sheet, the user should disable manual selection of left turn treatment, and select whether the pedestrian timing will be included. The user also needs to define (or use the default values) for the ideal saturation flow rate, peak hour factor (PHF), percentage of heavy vehicles (HGV%), lost time per phase, area type, and values for minimum and maximum cycle lengths before performing signal parameter estimation in NeXTA. The QEM is called through NeXTA’s menu by going to File → Export → Microscopic Network and Traffic Control Data, and then selecting the Perform Quick Estimation Method (QEM) for Signals option in the dialog box, as shown in Figure 6.21. This operation will call the Excel QEM spreadsheet and perform the estimation of signal timing parameters for each defined signalized intersection in the network. The user also receives information about the demand loading period, and the volume conversion factor to be used with QEM, since QEM works with one-hour volumes only.

Figure 6.21: Starting QEM through NeXTA Interface
6.5 Web-Based User Interface

The interface developed within this research, shown in Figure 6.22, is a user-friendly software application that allows the user to view and edit the analyzed networks, and read the output results on different levels. It uses Google Earth as the background map application, making it easier for users to navigate. The web-based interface has a direct link to NeXTA and can visualize simulation inputs and outputs.

![Web-Based Network Editing Interface](image)

**Figure 6.22: Web-Based Network Editing Interface**

This software application is provided with the supporting documentation. The application is located in the “GET_Release” folder, under the name “WindowsFormsApplication1”. In order to use this application, the user needs to copy the entire “GET_Release” folder in the current project folder, and copy all NeXTA supporting files into the sub-folder called “webroot” (or this sub-folder can be the main project folder). This step ensures that the web-based interface and NeXTA are communicating properly.

When the application is started, the user will see the command window with the embedded Google Earth. There is a toolbar on the top of the window, shown in Figure 6.23. This toolbar contains the main commands to load, view and edit network data.

![Web-Based Application Toolbar](image)

**Figure 6.23: Web-Based Application Toolbar**
The icons “Go!”, “Refresh”, “Screen Grab” and “View in Google Maps”, as well as drop-down menus “Options” and “Layers”, are standard Google Earth features that provide additional options in network visualization. The menu “1. Open File” will load the network located in the “webroot” sub-folder. The user will see the network loaded onto the Google Earth map, as well as additional menu on the left side of the window, called “Traffic Simulation Data”. This menu contains different network layers that can be switched on or off as needed (Fig. 6.24).

![Traffic Simulation Data Layers](image1)

**Figure 6.24: Traffic Simulation Data Layers**

Switching among different layers will visualize different network elements, which the user can expand by clicking onto the + icon. By selecting a link in the network with the left mouse button, the user can see the link information, as shown in Fig. 6.25.

![Link Information](image2)

**Figure 6.25: Link Information**
Activating the “Node Layer” will show all the nodes within the network, with red placemarks showing signalized intersections, and yellow placemarks showing all other intersections. Clicking on the red placemark will offer the option of opening the QEM application for that intersections and assessing all signalized intersection data, as shown in Fig. 6.26.

**Figure 6.26: Open QEM Option**

All other layers work much the same way, and the user can visualize link volumes, zone production, network bottlenecks, traffic detectors, VMS signs, and work zones.
7. **SR 201 TEST CASE**

The developed tool was tested on the SR 201 repaving project, that UDOT undertook in summer of 2014 (SR 201: 9450 W to 5600 W Concrete Overlay / Ramp Widening). The project included lane closures along SR 201 between 5600 W and 9450 W, that impacted expressway capacities/travel times, as well as signalized intersection capacities along this section. Because of the reduction in capacities, it is expected to have traffic switching to alternate routes to bypass the work zone. The developed tool was used to estimate the switching rate through DTA, identify alternate corridors, and assess the performance of signalized intersections in the vicinity. To better capture the work zone impacts, the network that was used for this purpose encompassed a larger area around SR 201, from I-15 on the east to SR 201 / I-80 interchange on the west side, and from 400 N to 4100 S on the north and south sides respectively. It includes all freeways, major and minor arterials, and a total of 123 signalized intersections. The network was created from the Regional MPO Planning Network through sub-area cut, as previously described. The original OD matrices were used to build the test case network, with automatic (ODME features in NeXTA) and manual modifications. Since the PM peak is critical, the network was created and calibrated for the 3:00 – 6:00 PM period. The test network is given in Figure 7.1.

Two scenarios were used in analysis, the Base network that represents regular conditions before the work zone implementation. The Work Zone scenario introduces work zones along the SR 201 corridor, with lane reductions and intersection reconfigurations.

![Figure 7.1: Network for SR 201 Test Case](image-url)
7.1 Network Validation

The test case network was validated based on the traffic volumes on freeways and arterials. For the purpose of validation, a total of 64 sensor locations were used. The freeway data were extracted and averaged from the UDOT’s PeMS system for three days in January of 2014 (28th, 29th and 30th) for the three-hour PM peak period. The arterial volume data were extracted and calculated from the UDOT’s Signal Performance Metrics system for January 29th 2014 as the representative day. The data used in this process are provided in the supporting materials. The locations of the sensors used for validation are shown in Figure 7.2.

![Figure 7.2: Sensor Locations](image)

The validation was performed for the middle hour, 4:00 – 5:00 PM. Figure 7.3 shows network validation that compares observed and simulated traffic volumes passing through the sensor locations. The high R square value of close to 0.97 shows a high correlation between the two data sets.
7.2 Results

Because of the unique system design developed in this research, the impacts of the work zones can be easily and quickly assessed on multiple levels. The DTA features provide the results for traffic rerouting in the vicinity of the work zones, the traffic flow models provide travel times and speeds along the impacted routes, while the signal control application provides impacts on intersection and arterial levels.

Table 7.1 shows links that represent the most heavily used alternate routes in the Work Zone scenario, with more than 10% of traffic switching from SR 201 to alternatives. It can be seen that most of the traffic is rerouting along different sections of I-80 and 3500 South. The average volume increase along the alternate routes is close to 16%.
<table>
<thead>
<tr>
<th>Route</th>
<th>Base volume (veh/3hr)</th>
<th>WZ volume (veh/3hr)</th>
<th>Volume difference</th>
<th>% difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>I-80 WB to I-15NB ramp</td>
<td>3661</td>
<td>4602</td>
<td>941</td>
<td>25.7</td>
</tr>
<tr>
<td>I-15NB to I-80 WB ramp</td>
<td>4046</td>
<td>4969</td>
<td>923</td>
<td>22.8</td>
</tr>
<tr>
<td>I-80</td>
<td>4620</td>
<td>5574</td>
<td>954</td>
<td>20.6</td>
</tr>
<tr>
<td>I-80</td>
<td>4641</td>
<td>5569</td>
<td>928</td>
<td>20.0</td>
</tr>
<tr>
<td>3500 South</td>
<td>1042</td>
<td>1240</td>
<td>198</td>
<td>19.0</td>
</tr>
<tr>
<td>3500 South</td>
<td>1076</td>
<td>1274</td>
<td>198</td>
<td>18.4</td>
</tr>
<tr>
<td>I-80</td>
<td>5202</td>
<td>6149</td>
<td>947</td>
<td>18.2</td>
</tr>
<tr>
<td>I-80</td>
<td>5280</td>
<td>6221</td>
<td>941</td>
<td>17.8</td>
</tr>
<tr>
<td>3500 South</td>
<td>1184</td>
<td>1394</td>
<td>210</td>
<td>17.7</td>
</tr>
<tr>
<td>3500 South</td>
<td>1195</td>
<td>1404</td>
<td>209</td>
<td>17.5</td>
</tr>
<tr>
<td>I-80</td>
<td>5427</td>
<td>6369</td>
<td>942</td>
<td>17.4</td>
</tr>
<tr>
<td>3500 South</td>
<td>1246</td>
<td>1456</td>
<td>210</td>
<td>16.9</td>
</tr>
<tr>
<td>I-80</td>
<td>5612</td>
<td>6555</td>
<td>943</td>
<td>16.8</td>
</tr>
<tr>
<td>3500 South</td>
<td>1264</td>
<td>1474</td>
<td>210</td>
<td>16.6</td>
</tr>
<tr>
<td>I-80</td>
<td>5910</td>
<td>6851</td>
<td>941</td>
<td>15.9</td>
</tr>
<tr>
<td>I-80</td>
<td>6577</td>
<td>7524</td>
<td>947</td>
<td>14.4</td>
</tr>
<tr>
<td>3500 South</td>
<td>1362</td>
<td>1553</td>
<td>191</td>
<td>14.0</td>
</tr>
<tr>
<td>3500 South</td>
<td>1420</td>
<td>1611</td>
<td>191</td>
<td>13.5</td>
</tr>
<tr>
<td>3500 South</td>
<td>1396</td>
<td>1583</td>
<td>187</td>
<td>13.4</td>
</tr>
<tr>
<td>3500 South</td>
<td>1442</td>
<td>1633</td>
<td>191</td>
<td>13.2</td>
</tr>
<tr>
<td>I-80</td>
<td>7186</td>
<td>8133</td>
<td>947</td>
<td>13.2</td>
</tr>
<tr>
<td>I-80</td>
<td>7207</td>
<td>8154</td>
<td>947</td>
<td>13.1</td>
</tr>
<tr>
<td>I-80</td>
<td>7219</td>
<td>8161</td>
<td>942</td>
<td>13.0</td>
</tr>
<tr>
<td>3500 South</td>
<td>1444</td>
<td>1627</td>
<td>183</td>
<td>12.7</td>
</tr>
<tr>
<td>Route</td>
<td>Pre-Reroute</td>
<td>Post-Reroute</td>
<td>Change</td>
<td>% Decrease</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>--------------</td>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>3500 South</td>
<td>1260</td>
<td>1416</td>
<td>156</td>
<td>12.4</td>
</tr>
<tr>
<td>I-80</td>
<td>7491</td>
<td>8416</td>
<td>925</td>
<td>12.3</td>
</tr>
<tr>
<td>3500 South</td>
<td>1604</td>
<td>1794</td>
<td>190</td>
<td>11.8</td>
</tr>
<tr>
<td>I-80</td>
<td>4189</td>
<td>4682</td>
<td>493</td>
<td>11.8</td>
</tr>
<tr>
<td>3500 South</td>
<td>1106</td>
<td>1232</td>
<td>126</td>
<td>11.4</td>
</tr>
<tr>
<td>3500 South</td>
<td>1151</td>
<td>1277</td>
<td>126</td>
<td>10.9</td>
</tr>
</tbody>
</table>

Similarly, table 7.2 shows the routes from which most of the traffic was rerouted to alternatives. As expected, the majority of traffic was rerouted from SR 201, but also from some adjacent impacted arterials, such as 2100 South and 8400 West. The average volume decrease along the impacted routes is also close to 16%.
Table 7.2: Traffic Rerouting from Impacted Routes

<table>
<thead>
<tr>
<th>Route</th>
<th>Base volume (veh/3hr)</th>
<th>WZ volume (veh/3hr)</th>
<th>Volume difference</th>
<th>% difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>SR-201</td>
<td>2303</td>
<td>1353</td>
<td>-950</td>
<td>-41.3</td>
</tr>
<tr>
<td>SR-201</td>
<td>2503</td>
<td>1549</td>
<td>-954</td>
<td>-38.1</td>
</tr>
<tr>
<td>SR-201</td>
<td>4164</td>
<td>2929</td>
<td>-1235</td>
<td>-29.7</td>
</tr>
<tr>
<td>SR-201</td>
<td>5450</td>
<td>4068</td>
<td>-1382</td>
<td>-25.4</td>
</tr>
<tr>
<td>SR-201 WB</td>
<td>3160</td>
<td>2448</td>
<td>-712</td>
<td>-22.5</td>
</tr>
<tr>
<td>SR-201 EB</td>
<td>2727</td>
<td>2178</td>
<td>-549</td>
<td>-20.1</td>
</tr>
<tr>
<td>I-80 WB to SR 201 WB</td>
<td>2173</td>
<td>1743</td>
<td>-430</td>
<td>-19.8</td>
</tr>
<tr>
<td>2100 South</td>
<td>2900</td>
<td>2339</td>
<td>-561</td>
<td>-19.3</td>
</tr>
<tr>
<td>2100 South</td>
<td>2982</td>
<td>2421</td>
<td>-561</td>
<td>-18.8</td>
</tr>
<tr>
<td>2100 South</td>
<td>3248</td>
<td>2678</td>
<td>-570</td>
<td>-17.5</td>
</tr>
<tr>
<td>SR-201</td>
<td>8222</td>
<td>6907</td>
<td>-1315</td>
<td>-16.0</td>
</tr>
<tr>
<td>SR-201</td>
<td>9053</td>
<td>7676</td>
<td>-1377</td>
<td>-15.2</td>
</tr>
<tr>
<td>8400 West</td>
<td>1678</td>
<td>1432</td>
<td>-246</td>
<td>-14.7</td>
</tr>
<tr>
<td>SR-201 EB</td>
<td>1451</td>
<td>1267</td>
<td>-184</td>
<td>-12.7</td>
</tr>
<tr>
<td>SR-201</td>
<td>2484</td>
<td>2176</td>
<td>-308</td>
<td>-12.4</td>
</tr>
<tr>
<td>2100 South</td>
<td>1191</td>
<td>1048</td>
<td>-143</td>
<td>-12.0</td>
</tr>
<tr>
<td>2100 South</td>
<td>1155</td>
<td>1017</td>
<td>-138</td>
<td>-11.9</td>
</tr>
<tr>
<td>8000 West</td>
<td>1290</td>
<td>1141</td>
<td>-149</td>
<td>-11.6</td>
</tr>
<tr>
<td>SR-201</td>
<td>10008</td>
<td>8864</td>
<td>-1144</td>
<td>-11.4</td>
</tr>
<tr>
<td>2100 South</td>
<td>1345</td>
<td>1205</td>
<td>-140</td>
<td>-10.4</td>
</tr>
<tr>
<td>SR-201</td>
<td>11792</td>
<td>10588</td>
<td>-1204</td>
<td>-10.2</td>
</tr>
<tr>
<td>SR-201</td>
<td>10824</td>
<td>9731</td>
<td>-1093</td>
<td>-10.1</td>
</tr>
</tbody>
</table>

Reconfigurations of signalized intersections and changes in traffic volumes also impact delays experienced at these locations. Through the signal control application embedded into the tool, it
is possible to assess these impacts without using separate software for signal control analysis. Table 7.3 shows the most impacted intersections after the introduction of the work zones. These are the intersections along the impacted segments of SR 201, as well as along the alternate routes where most of the traffic is being rerouted.

Table 7.3: Impacts on Signalized Intersections

<table>
<thead>
<tr>
<th>Intersection</th>
<th>Base intersection delay (s)</th>
<th>Work zone intersection delay (s)</th>
<th>Delay difference (s)</th>
<th>% difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>8400 West &amp; SR-201</td>
<td>23.2</td>
<td>94.1</td>
<td>70.9</td>
<td>305.4</td>
</tr>
<tr>
<td>8400 West &amp; 3500 South</td>
<td>22.1</td>
<td>55.6</td>
<td>33.5</td>
<td>151.7</td>
</tr>
<tr>
<td>2200 West &amp; 4100 South</td>
<td>17.5</td>
<td>35.0</td>
<td>17.5</td>
<td>100.1</td>
</tr>
<tr>
<td>SR-201 &amp; 8000 West</td>
<td>16.8</td>
<td>25.8</td>
<td>9.0</td>
<td>53.3</td>
</tr>
<tr>
<td>Meadow Br &amp; 700 West</td>
<td>27.8</td>
<td>33.0</td>
<td>5.2</td>
<td>18.8</td>
</tr>
<tr>
<td>5600 West &amp; 3500 South</td>
<td>30.8</td>
<td>35.8</td>
<td>5.0</td>
<td>16.3</td>
</tr>
<tr>
<td>3500 South &amp; 6400 West</td>
<td>13.9</td>
<td>16.0</td>
<td>2.1</td>
<td>15.2</td>
</tr>
<tr>
<td>900 West &amp; 1300 South</td>
<td>33.5</td>
<td>36.8</td>
<td>3.3</td>
<td>9.9</td>
</tr>
<tr>
<td>5600 West &amp; 400 South</td>
<td>89.8</td>
<td>98.6</td>
<td>8.8</td>
<td>9.8</td>
</tr>
<tr>
<td>Meadow Br &amp; 3900 South</td>
<td>21.0</td>
<td>23.0</td>
<td>2.0</td>
<td>9.4</td>
</tr>
<tr>
<td>Redwood R &amp; Meadow Br</td>
<td>44.0</td>
<td>47.8</td>
<td>3.9</td>
<td>8.8</td>
</tr>
<tr>
<td>7200 West &amp; 3500 South</td>
<td>12.3</td>
<td>13.1</td>
<td>0.9</td>
<td>7.1</td>
</tr>
<tr>
<td>5600 West &amp; Redwood R</td>
<td>164.4</td>
<td>175.5</td>
<td>11.2</td>
<td>6.8</td>
</tr>
</tbody>
</table>

These results show the ability of the developed tool to quickly perform before-after analysis for work zones, but also for any other events that have impacts on road capacities, whether freeways or arterials, such as adverse weather, incidents, special events and similar. The impacts can be assessed on multiple levels because of the successful integration of DTA, traffic flow models and a signal timing application. The web-based user interface allows the users to quickly assess the performance they need, and to represent the results in a visually appealing manner. The time needed to perform analysis and represent results with this tool is much shorter than creating separate models in different traffic simulation tools for different simulation levels. An added value is the existence of the underlying networks (such as the Regional MPO Planning Network), which can be quickly and easily transformed and used for any subarea. These features give the developed tool a significant advantage over other similar tools. Creating a sub-network from a
larger planning macroscopic network still requires some manual adjustments, especially for intersections which are not best presented in those models. This is also needed to ensure accurate representation and results for signalized intersections. The node and movement editing features in NeXTA make this task straightforward and fast with only simple modifications, without the need to create new network features.

Calibration of a sub-network also needs to be performed after editing. The calibration will depend on the network size, available data and expected outcomes. However, for most impact analysis studies within a same area, the sub-network can be created, edited and calibrated only once, and then reused for different purposes. This is the case with the network presented here, which includes all freeways, major arterials and 123 signalized intersections. This network was edited and calibrated, and can be reused for any traffic impact analysis within this region. Smaller networks, consisting of a segment of a freeway and adjacent arterials, take much less time to edit and calibrate. One such network is presented in Appendix 4, and it took significantly less data, time and effort to edit and calibrate, and the scenario analysis were performed in a very short time frame.

REFERENCES


APPENDIX 1: Cloud Computing/Google Earth Based Architecture
As a new form of distributed computing (ITU, 2009), cloud computing is defined as a software model, as in Figure 1, in which shared and inter-connected computing resources, e.g., networks, servers, storage, applications and services, can be rapidly and automatically acquired and released as an on-demand self service (Chappell, 2009). In other words, computing power and storage space are shared and purchased by multiple customers as services. These computing resources can be automatically provisioned and released, with little to no human interaction with each service provider. Customers decide the initial storage space and computing power their applications require. Later, customers can dynamically adjust their needs whenever their applications require more or less space or power.

![Cloud Computing Model](image)

Figure 1: Cloud Computing Model

Cloud computing’s major evolution from traditional distributed computing is that the underlying computing resources of cloud-based services and software are entirely abstracted from the consumers of the software and services. The consumers focus on the business developments and service definitions while the cloud service providers take responsibility for the performance, reliability and scalability of the computing environment.
Advantages of Cloud Computing

The benefits of selecting cloud computing as the underlying platform for an advanced information provision system are listed below.

1. Integrated Computing and Storage

As stated in its definition, the cloud computing model integrates computing power and storage. And these computing resources are abstracted from the cloud computing consumers, in this case, the advanced traveler information provider, which eliminates the burdens of setting up hardware and software to store collected traffic information. With the help of the cloud computing providers, geologically distributed datacenters can be seamlessly accessed.

2. Scalable and Customized Computing Resources

Parallel to how people consume electricity power and other utilities, cloud computing resource customers do not need to understand the component devices or infrastructure required to provide the service. Computing power and storage are rented from the cloud computing service providers and can be provisioned and released as the demand for computing power and storage goes up and down. With this flexibility in computing environment, situations such as service breakdowns due to surging inquiries for traffic information from an advanced traveler information system during a severe weather event can be prevented. Furthermore, costs can be reduced when unnecessary resources are released.

3. Performance, Security and Maintenance

Cloud computing service providers have already addressed many vital performance and security issues faced by common web application designs. For example, load balancing is a decisive issue related to application performance, and its implementation requires specific expertise and experience, of which smaller organizations and agencies often lack. Fortunately, many cloud computing platforms have implemented built-in load balancers which help to preserve users’ precious time and resources so that they can focus on
business delivery. Prominent cloud computing service providers, such as Microsoft, Amazon and Google, have strong technical and supportive teams and can provide quick responses to potential security issues, thus assuring system security and integrity.

4. Ease of Information Provision

To eliminate the need to install and run the application on the customer's own computers and simplify maintenance and support, cloud application services, or Software as a Service (SaaS), deliver software as a service over the Internet. The software and its associated data are hosted centrally in the cloud while the service is accessed by users using a web browser.

This software delivery model is well-suited for traveler information provision service since the most preferable way for users to access the traffic information is by a web browser. This web-based service model also enables service compatibility for multiple platforms, including Windows, Linux and Macintosh computers, and any other mobile devices with web browsing capabilities. In addition, a traveler information provision service implemented as a cloud service also circumvents distributed software updating and patching as all core components reside on the server side.

In a summary, due to the above listed benefits, cloud computing is a very appropriate, reliable information provision platform for agencies. Its open characteristics also encourage data sharing with other agencies and private partners.

**MapReduce as a Specific Cloud Computing Software Framework**

The following discussions aim to introduce a specific cloud computing model, MapReduce, to design data-intensive software systems for managing and manipulating a large volume of data. MapReduce was introduced by Google Inc. in 2004 for processing huge datasets on a cluster of computers. It is derived from the *map* and *reduce* combiners from a functional language like Lisp.
In a typical MapReduce model, as shown in Figure 2, a computational process takes in a set of input key/value pairs and produces a set of output key/value pairs (Dean and Ghemawat, 2004). The computation consists of two user defined functions: Map and Reduce. Map takes an input key/value pair and produces a set of intermediate key/value pairs. All intermediate values associated with the same intermediate key are grouped together by the function provided MapReduce library and passed to the user defined Reduce function. The Reduce function accepts an intermediate key and a set of values associated with that key. These values are then merged together to generate an output of a smaller set of values.

The strength of MapReduce is that it allows for distributed processing of the map and reduction operations. If each mapping operation is independent of the others, all maps can be executed in parallel – though practically it is limited by the data source and/or the number of CPUs or processing units available. Similarly, a set of reducers can perform the reduction phase – all that is required is that all outputs of the map operation that share the same key are presented to the same reducer at the same time. While this process can often appear inefficient compared to algorithms that are more sequential, MapReduce can be applied to significantly larger datasets. Additionally, this process also provides the possibility of recovering from partial servers or
storage failure during the operation. For instance, if one mapper or reducer fails, the work can be rescheduled, as long as the input data is still available.

The MapReduce model has been adopted by Google for processing large amounts of crawled documents. Their experience demonstrates that a great performance improvement has been achieved in a large amount of data (Dean and Ghemawat, 2004). Meanwhile, although MapReduce was originally introduced by Google, there are several open source MapReduce frameworks, such as Apache Hadoop MapReduce and Disco. MapReduce libraries have been implemented in a number of programming languages, including C++, Java, Python, C# and so on, which gives the developers a number of choices to integrate MapReduce into their existing systems.

Recently, Microsoft introduced a new scripting language, SCOPE (Structured Computations Optimized for Parallel Execution) for large-scale data analysis. The target of SCOPE is to provide easy and efficient parallel processing of massive data sets. SCOPE is a high level declarative scripting language and has a strong resemblance to SQL. Thus, users with experience with relational database and SQL require little or no specific training to use SCOPE. It has been noted that our research is to design and implement a travel time reliability-based traveler information provision service over the cloud computing platform. Compared with the MapReduce model, there are few real-world application implementations with SCOPE on the cloud as SCOPE is still under development by Microsoft. Besides, the MapReduce programming model provides a well-defined map and reduce programming model, which is more suitable for implementation of the underlying travel time reliability engine in our system.
System Architecture and Data Flow

Figure 3: Cloud Computing-supported System Architecture

Server-side Components

As shown in Figure 3, the server is composed of four core components:

- Traffic measurement and historical pattern databases
- GPS map matching engine
- Data mining and fusion engine
- Reliable routing engine for work zone scenarios
Databases
It is desirable to store a large volume of loop detector, AVI and GPS trace data in distributed rational databases. The physical locations of these datacenters are transparent to the users and traffic system managers. Possible access interfaces, accordingly, must be provided to allow seamless information sharing among commuters, public-sector agencies and private traveler information providers. A cloud computing storage system offers new opportunities for potential public-private partnerships in sharing and trading different data streams.

GPS map matching engine
Map matching is an essential data processing service that converts raw GPS location data samples to useful traffic information in node-link traffic network representation form. User-provided GPS trajectories are processed in this module and fed into the subsequent data mining and fusion tasks.

Data mining and fusion engine
The data mining and fusion module extracts and integrates valuable end-to-end trip travel time variability information from various sources. In this engine, data from loop detectors, GPS, AVI and other sources are integrated into a single historical database, which is then queried and manipulated by the reliable routing engine.

Reliable routing engine for work zone scenarios
As the building block of the entire traffic information provision system, the reliable routing engine calculates routes under different criteria, based on live traffic data from the traffic data fusion and prediction engine, and further generates final route guidance information to end users. Upon receiving user request for the reliable path between a user specified origin and destination (OD) pair, this engine first generates a list of alternative paths between this OD pair. After that, path travel time statistics for each alternative path are calculated by a MapReduce mechanism.

Client-side Components
To make the service available to the greatest number of browsers, including mobile browsers on the smart phones, the computing requirements on the client side are designed to be limited to the
minimum. The main functions of client-side code are displaying maps/results and accepting user input while all the computations are carried out at the server-side. The client-side code is implemented with AJAX to provide interactive web pages.

Figure 4: Travel Time Reliability Information Provision Interface for work zone scenarios

As shown in Figure 4, the left-side of the page is designed to display a route network with Microsoft Bing Maps. Microsoft Bing Maps’ Interactive SDK for AJAX v6.3 is utilized to provide user interaction with the map and display the routes. In order to request path travel time, users must first specify their origin and destination of a path. Two flexible input methods are supplied: 1) users can select their origin and destination on the map; or 2) users can input addresses for their origin and destination in the textboxes. Once a user successfully provides the origin and destination information, a travel time reliability request is sent to server.

Five possible routes are calculated on the server and returned back to the client for display: quickest (in time) route, shortest (in distance) route, eco (most environmentally-friendly) route, safest route and detour for each origin and destination. Computed route information includes individual route travel times, route travel distances, safety indices and route coordinates. In
addition, a chart with the daily travel time variability information for every route is also generated on the server.

The calculated results are processed in the client-side browser with embedded JavaScript, including displaying alternative routes on the map, presenting detailed information about the alternative routes and displaying route travel time reliability. Bing Map’s Interactive SDK provides rich APIs for customized route display.

As an example presented in

Figure 4, there are 3 alternative routes between origin A and destination B, because 1) the quickest and shortest routes are the same routes, and 2) the eco and safest routes are the same as well. Average travel times, distances and safety ratings for each route are displayed on the right table. Daily travel time variability for each route is also displayed as an upper and lower bound on the rightmost bottom side of the display. This is based on the computation result generated for this specific routing request.
APPENDIX 2: Calibrating Work Zone Capacity
The Highway Capacity Manual (HCM) 2010 (1) defines capacity as “the maximum sustainable hourly flow rate at which persons or vehicles reasonably can be expected to traverse a point or a uniform segment of a lane or roadway during a given time period under prevailing roadway, environmental, traffic, and control conditions.” Vehicle (roadway) capacity is defined as “the maximum number of vehicle that can pass a given point during a specified period under prevailing roadway, traffic, and control conditions.” This definition assumes that there is no influence from downstream traffic operations, such as a queue spillback into the analysis point. Prevailing traffic conditions are categorized as roadway (geometric elements), traffic (vehicle type, directional and lane distribution and driver population) and control conditions.

The basic freeway capacities in ideal conditions are based on the free-flow speeds (FFS) and are given in Table 1.

<table>
<thead>
<tr>
<th>FFS (mph)</th>
<th>Capacity (pc/h/ln)</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 – 75</td>
<td>2400</td>
</tr>
<tr>
<td>65</td>
<td>2350</td>
</tr>
<tr>
<td>60</td>
<td>2300</td>
</tr>
<tr>
<td>55</td>
<td>2250</td>
</tr>
</tbody>
</table>

Roadway capacity in a work zone is reduced due to a variety of factors (2). The most important factors that influence this capacity are as follows:

- Work zone speed limits
- Work intensity (work zone type)
- Percentages of trucks
- Number of lanes
- Number of lane closures
- Lane width
- Lateral clearance
- Work zone layout (lane merging, lane shifting, and crossover)
- Length of closure
- Presence of ramps
- Work zone location (urban or rural)
- Work zone duration (long-term or short-term)
- Work time (daytime or nighttime)
- Work day (weekday or weekend)
- Type of control devices and their placement
- Weather conditions (sunny, rainy, or snowy)
- Pavement conditions (dry, wet, or icy)
- Pavement grade
- Driver composition

There have been different approaches in the literature in selecting the lane capacity in the work zone areas. The two most widely used methods in the literature are the observable maximum throughput under relatively free-flow conditions before the formation of a traffic queue, and the discharge flow rate under the queued conditions (2). Queue discharge flow rate represents traffic flow that has just passed through a bottleneck and is accelerating back to the free-flow speed. Queue discharge flow is relatively stable as long as there is not another nearby bottleneck downstream. The HCM 2010 suggests that the queue discharge flow rate is lower than the maximum flows observed before breakdown, which is usually considered as the capacity. Since traffic conditions vary between pre-queuing and queuing conditions at work zone locations, a more precise work zone analysis may consider using both of the above work zone capacity values: one for pre-queuing conditions, and the other for queuing conditions. If this is not a viable option, then the analyst can use engineering judgment to select one of the methods, based on the prevailing conditions at the analyzed work zone locations.

State DOTs have selected different work zone capacity values based on the prevailing conditions. Some of these adopted values for freeway work zones are summarized in (3), and are presented in Table 2.
Table 2: Work Zone Capacity Values Adopted by State DOTs

<table>
<thead>
<tr>
<th>State</th>
<th>2 lanes to 1 lane</th>
<th>3 lanes to 1 lane</th>
<th>3 lanes to 2 lanes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Florida</td>
<td>1,800 v/h</td>
<td>-</td>
<td>3,600 v/h</td>
</tr>
<tr>
<td>Wisconsin</td>
<td>1,500 pc/h/ln</td>
<td>1,500 v/h</td>
<td>1,500 pc/h/ln</td>
</tr>
<tr>
<td>Nevada</td>
<td>1,500-1,600 pc/h/ln</td>
<td>1,500-1,600 pc/h/ln</td>
<td>1,500-1,600 pc/h/ln</td>
</tr>
<tr>
<td>Massachusetts</td>
<td>1,500 v/h</td>
<td>1,500 v/h</td>
<td>3,000 v/h</td>
</tr>
<tr>
<td>Hawaii</td>
<td>1,600 pc/h/ln</td>
<td>1,600 pc/h/ln</td>
<td>1,600 pc/h/ln</td>
</tr>
<tr>
<td>Iowa</td>
<td>1,450 v/h/ln</td>
<td>-</td>
<td>1,450 v/h/ln</td>
</tr>
<tr>
<td>New York</td>
<td>1,800 pc/h/ln</td>
<td>1,600 pc/h/ln</td>
<td>1,700 pc/h/ln</td>
</tr>
<tr>
<td>New Jersey</td>
<td>1,300-1,400 v/h/ln</td>
<td>1,200-1,300 pc/h/ln</td>
<td>3,000-3,200 v/h</td>
</tr>
</tbody>
</table>

v/h – vehicles per hour; v/h/ln – vehicles per hour per lane; pc/h/ln – passenger cars per hour per lane

A study conducted in Illinois (4) looked into the work zone lane capacities for different speed limits, work zone activity intensities and control strategies. The conclusions on the capacities are as follows:

1200 – 1550 pc/h/ln, for 45 mph speed limit, where:
   1200 pc/h/ln: conditions with flaggers and queues
   1550 pc/h/ln: conditions with no work activity, no speed management, no queue

1600 – 1750 pc/h/ln, for 55 mph speed limit, where:
   1600 pc/h/ln: dynamic speed-feedback sign, no work activity, no queue
   1750 pc/h/ln: short distance WZ, no work activity, no queue

Tables 3 and 4 provide summarized data on work zone capacities obtained from the previous studies, and published in (2). These are the defaults that can be used in the absence of local calibrated data, and they are given separately for short-term and long-term work zones.
Table 3: Work Zone Lane Capacity Defaults for Short-Term Work Zones

<table>
<thead>
<tr>
<th>Short-Term Work Zone Capacity (pc/h/ln)</th>
<th>Arterial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeway / Highway</td>
<td>Urban</td>
</tr>
<tr>
<td>1,200 – 1,600</td>
<td>600</td>
</tr>
<tr>
<td></td>
<td>Rural</td>
</tr>
<tr>
<td></td>
<td>400</td>
</tr>
</tbody>
</table>

Table 4: Work Zone Lane Capacity Defaults for Long-Term Work Zones

<table>
<thead>
<tr>
<th>Default Type</th>
<th>Long-Term Work Zone Capacity (pc/h/ln)</th>
<th>Normal Lanes to Reduced Lanes (Freeways)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2 - 1</td>
<td>3 - 2</td>
</tr>
<tr>
<td>Range</td>
<td>1,200-</td>
<td>1,300-</td>
</tr>
<tr>
<td></td>
<td>1,800</td>
<td>1,600</td>
</tr>
<tr>
<td>Single Value</td>
<td>1,400</td>
<td>1,450</td>
</tr>
</tbody>
</table>

The work zone capacities are usually not constant values, and they can vary due to many factors. The most significant and researched factors that impact work zone capacity variation are as follows (2):

**Driver Characteristics** – Driver characteristics may vary from hour to hour, from day to day, and from one region to another. This variation is mainly due to the ability of the driver population to adapt to the changing conditions. Commuter drivers are expected to be more familiar with the route and the work zone configuration. Therefore, they can proceed through the work zone with shorter headways and higher flows. Some studies examined the effect of driver population at freeway reconstruction zones. Based on a factor of 1.0 for commuter traffic, a driver population factor of 0.93 was estimated for the afternoon peak period, and a driver population factor of 0.84 was estimated for weekends. The driver population factor was responsible for more of a capacity reduction on weekends compared with the capacity on weekdays.
**Nonrecurring Events** – Nonrecurring events, such as inclement weather and crashes, further reduce capacity within a work zone. For instance, inclement weather may reduce the capacity of freeways by 1 percent to 22 percent, depending on the intensity of the weather condition (1).

**Work zone Duration** – The duration of the work zone has an impact on driver behavior in such a way that after a period of time, drivers adjust to the changed conditions and capacity and speeds may go up. Some studies found that the average capacity at long-term work zones was noticeably greater than that at short-term zones, as drivers became more familiar with the work zones. Long-term work zones may have capacities as much as 150 pc/h/ln higher than short-term zones.

**Random Effect** – Even when all prevailing conditions are held constant, studies found that capacity was a random variable, because of stochastic variations in vehicle mix, lane distribution, and driver behavior.

In addition to the described factors that influence work zone capacity, it also may be specific to different times of the day, different demographic groups (age/experience), and different populations reflecting regional or local tendencies. Therefore, if different time-of-day analysis is considered critical and resources are available, it is recommended to create different time-of-day models, such as AM peak, off-peak, PM peak, weekend peak, and weekend off-peak, to reflect the variable capacity, as well as the variable demand in analysis tools. Also, for longer duration work zones, it is recommended that interim analysis be performed to better reflect varying capacities. Different analysis tools may accommodate various time periods. Some sketch-planning analysis tools can analyze longer time periods, such as multiple days, months, or even years, which is typically beyond the capability of other analysis tools such as macro-, meso-, and microscopic simulation models. The analysis period should be long enough to include no queue at the beginning, queue buildup, and queue dissipation at the end of the analysis period.

**REFERENCES**


APPENDIX 3: West Jordan Work Zone Network Development and Analysis
Transportation Network Analysis with Work Zone Application
Prepared by Jeffrey Taylor and Jinjin Tang

Step-by-step tutorial for importing and exporting network:
https://docs.google.com/document/d/1nHKOo8buhCReS41IUFAAdzhXIAHmijU1TfdR98i-HQk8/edit
Introduction to NEXTA/DTALite Tool Package:
http://code.google.com/p/nexta/
Data Sets: http://nexta.googlecode.com/files/Lesson%201.zip

The City of West Jordan will soon start a construction project to replace stormwater pipes under 9000 South between 1300 West and 700 West. In order to complete this project, 9000 South must be partially closed (from 2 lanes in each direction to 1 lane in each direction) to create a safe work zone for the repair crews. You (and an optional partner) have been tasked with using a Dynamic Traffic Assignment (DTA) model to evaluate the travel impacts (congestion, delay, etc.) associated with partially closing 9000 Southh.

This assignment will require preparing two different traffic simulation models - one in the initial condition (without the work zone), and one in the work zone condition. In preparing these two models, you will acquire the skills described in the following learning objectives.

Learning Objectives:

1. Understand how to view/edit network attributes in NeXTA and GIS
2. Run a basic traffic simulation, comparing two different scenarios
3. Understand how basic network attributes affect traffic simulation results

Step 1: Download and Open NeXTA, Open the West Jordan Network

Before going into too much detail, first makes sure you’re using the most up-to-date version of NeXTA, and open the West Jordan network.

Step 1.1: Download NeXTA at the Project website using the following link:
http://code.google.com/p/nexta/downloads/list

Step 1.2: Extract the zip file to a known location on your computer, and open the NEXTA_32.exe file in Internal Release folder.
Step 1.3: Open the West Jordan Network in NeXTA

In NeXTA, go to File -> Open Traffic Network Project

In the Internal Release folder, go to the sample data sets/Salt_Lake_City_West_Jordan folder, select the Base_Condition.tnp file, and click Open.
NeXTA will open the network, and display the **File Loading Status window**. The File Loading Status window displays information about the network currently open in NeXTA, including information about the number of links, nodes, and zones/activity locations in the network. This window can also be accessed by going to **File -> Check Data Loading Status**.

**Step 2: Viewing/Editing Network Attributes in NeXTA**

Network objects primarily consist of links, nodes, and zones. A driver starts and ends their trip at a zone, traveling along road segments (links) between the origin and destination. Links are connected together at nodes, where a node may represent an intersection or a simple connection between two road segments.

Since vehicles only travel along links, passing nodes between their origin and destination, trip details (such as travel time, distance, speed, etc.) are heavily dependent upon link and node attributes. The most important link attributes are typically link length, speed limit, number of lanes, and capacity. Since nodes typically represent intersections, their important attributes typically include node control type (signalized intersection, stop-controlled intersection, no control, etc.) and traffic signal-related attributes.

This section will quickly explain how to view and edit these network object attributes.

**Step 2.1:** To quickly view most link or node attributes, simply select a link or node using the Select Object tool, and look at the attributes in the GIS Layer Panel in the bottom right corner of the screen. (Note, not all attributes are displayed in this panel.)

<table>
<thead>
<tr>
<th>Link Attributes</th>
<th>Node Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Data</td>
</tr>
<tr>
<td>Link ID</td>
<td>5017</td>
</tr>
<tr>
<td>Type</td>
<td>Highway/Expres.</td>
</tr>
<tr>
<td>Node Name</td>
<td>Redwood Rd.</td>
</tr>
<tr>
<td>From Node ID</td>
<td>5017</td>
</tr>
<tr>
<td>To Node ID</td>
<td>11146</td>
</tr>
<tr>
<td>Speed Limit</td>
<td>43</td>
</tr>
<tr>
<td>Length (mile)</td>
<td>0.250</td>
</tr>
<tr>
<td>FTTT (min)</td>
<td>0.348</td>
</tr>
<tr>
<td># of Lanes</td>
<td>3</td>
</tr>
<tr>
<td>Lane Capa</td>
<td>285</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node ID</td>
<td>5017</td>
</tr>
<tr>
<td>Control Type</td>
<td>Pretimed Signal</td>
</tr>
<tr>
<td>X</td>
<td>-111.938751</td>
</tr>
<tr>
<td>Y</td>
<td>40.609517</td>
</tr>
<tr>
<td>Associated...</td>
<td>0</td>
</tr>
<tr>
<td>Cycle Length</td>
<td>60 sec</td>
</tr>
</tbody>
</table>

Alternatively, after selecting the link or node, right-click near the object and select either **Edit Link Properties** or **Node Properties**. Selecting Edit Link Properties opens the Link Properties dialog box, shown below. These dialog boxes offer the ability to edit individual link and node attributes quickly and easily - simply replace the text/values in the appropriate field, select OK, and click the Save button on the Tool Bar to save your changes to the network.
Step 3: Running a Traffic Simulation

Since the objective is to evaluate the effects of the work zone located on 9000 South, we must prepare two networks - one with work zone and one without the work zone (initial condition). Before preparing the network, let’s run the traffic simulation for the initial condition to generate the simulation results which we will later use for comparison.

Step 3.1: Traffic simulations can be quite complex, with many different settings and options, but in this case the simulation settings have mostly been provided for us. To run the traffic simulation in NeXTA, simply click the button on the MOE Toolbar. This will open a dialog box with simulation settings.
We’ll learn more about these settings in later lessons, but for now, simply press OK to start the simulation. Doing so will open the DTALite simulation window.

If the executable cannot be run and outputs an error message such as “the application has failed to start because its side-by-side configuration is incorrect”, you need to install additional Microsoft Visual C++ 2008 Redistribution Package.

Allow the simulation to run until it is finished (the window will close automatically). Once complete, NeXTA will display another window describing the simulation run (shown below). Select Yes to view the simulation summary file (output_summary.csv).

**Step 4: Create the Work Zone Network**

When creating comparison networks, it is often a good idea to create a copy of the network first. We usually do this because we want to preserve simulation results and initial network attributes, as well as to make comparison easier (we can open multiple networks in NeXTA at the same time).

**Step 4.1:** Copy the West Jordan Network to create the work zone model. First, go to File -> Open Project Folder in NeXTA. This will open the folder containing the input files for the West Jordan network. Browse to the sample_data folder in the Internal Release folder, which contains the West Jordan network.
Copy the “Salt_Lake_City_West_Jordan” folder, and paste it within the same sample_data folder, and change the folder name to “West_Jordan_WZ”. Open this newly created folder and change the TNP file name from “Base_Condition.tnp” to “West_Jordan_WZ.tnp”.

**Step 4.2:** Open this new West_Jordan_WZ model in NeXTA (following Step 1). Then, following the instructions in Step 2, reduce the number of lanes on all links between Node 1 and Node 3 (in both directions) to 1 lane, representing the work zone condition in which one lane is closed in each direction on 9000 Southh. **Remember to save the network after you finish editing the network to save your changes.**

**Step 4.3:** Run the traffic simulation again, following the instruction in Step 3. Open the output summary file to answer the following questions.

**Step 5: Compare the Simulation Results for Both Networks (with and without work zone)**

**Step 5.1:** Close NeXTA. Open NEXTA_32.exe again, and go to File -> Close to close the empty network that is shown initially. Go to File -> Open to open the West_Jordan_WZ network, and close the File Loading Status Window when it opens. Then open the Base_Condition network (without work zone), and close the File Loading Status Window again.

**Step 5.2:** We now have two networks loaded in NeXTA at the same time. Go to the Window menu and select Tile Vertically, then also select Synchronized Display. This will allow us to move to the same locations in both networks at the same time, and allow us to directly compare simulation results at those locations. If you followed these instructions correctly, your display should look like the figure below.
Step 5.3: To compare simulation results in much higher detail, we can use the Link MOE display in NeXTA. Select the Link MOE layer in GIS Layer Panel (make sure it is turned on, and is highlighted in red by clicking on the Link MOE text label), and zoom in to Node 5022 (you can use the search function with CTRL+F if you have trouble finding it). Use the Select Object tool again to select the link going from Node 11124 to Node 5022, opening the Link MOE window. Your display should look similar to the figure below.

This plot shows the number of vehicles passing through this link (in vehicles per hour per lane) for both simulations (the red line represents the simulation without work zone, and the purple line represents the simulation with work zone conditions). We can show different MOEs by selecting different options in the MOE Type 1 menu, and smooth the data by adjusting the aggregation interval. Switching to the 15 minute aggregation interval produces the following plot.
**Step 6: Visualize Simulation Results in Google Earth, Google Fusion Tables, and QGIS**

**Preliminary Step:** Download and install QGIS (or use ArcGIS if you prefer). 
(http://qgis.org/downloads/QGIS-OSGeo4W-1.8.0-1-Setup.exe)
APPENDIX 4: I-15 Work Zone Test-Case Network Analysis
The integration of the two modeling tools (DTA and signal estimation) in the backend simulation engine provides a basis for a much more detailed traffic analysis for many practically important network capacity improvement or traffic impact scenarios, such as long-term or medium-term work zones or responsive traffic diversion under severe traffic incidents. Freeway work zones have significant impacts within their area of influence, both on the freeway and adjacent arterials. Majority of tools for work zone analysis can estimate these impacts on the freeway level, but not on the arterial level where the freeway traffic is diverted around the work zone. The integrated DTA and QEM tool can overcome this problem and provide impact analysis on both levels.

The coupled software system design was tested on a real-world network in Salt Lake City, UT, shown in Figure 1 a), for a realistic freeway work zone scenario. The network includes a 4.8-mile stretch of I-15, the major arterials in the vicinity, and three freeway ramps. The I-15 corridor is split into 13 segments (S1 – S13) for further analysis. A total of 40 signalized intersections are represented in the network. This network is a subarea of the regional transportation planning network, and the current travel demand model and traffic data are used to create and validate the sub-network. The original OD demand matrices were used as input data, while NeXTA’s OD matrix estimation (ODME) feature was used to update the matrices and perform model validation. The current AADT values for the freeway and major arterials were obtained from UDOT, rescaled for the PM period directional traffic, and used in the validation process. A total of twenty-six sensor data points on freeways and arterials was used for this purpose. The model validation plot is given in Figure 1 b).
Three 3:00-6:00 PM models are analyzed and compared in the following three scenarios: (i) the Base model, which represents regular traffic operations; (ii) the Work Zone (WZ) model, where a work zone with a 50% reduction in capacity and a 45 mph speed limit is introduced on the Southbound (SB) segment S6 of I-15, between 3900 S and 4500 S streets; and (iii) the Work Zone plus VMS (WZ + VMS) model, where a VMS with an estimated 15% driver response was introduced on the I-15 SB link before the 3300 S freeway ramp. All models were run in the integrated DTA-QEM environment for 50 iterations, to ensure the convergence or reaching reasonable stability between the models.
**Results**

By comparing scenarios (i), (ii) and (iii), the work zone and VMS impacts were analyzed for the freeway and signalized intersections. Figure 2 a) and b) shows comparisons of freeway volumes and speeds as a percentage of the free-flow speed, given for SB freeway segments. Figure 2 c) shows a comparison of the average signalized intersection delays.

![Graph showing comparison of freeway volumes and speeds](image)

**a) 3hr freeway volumes**
Figure 2: Work Zone Analysis Results on Freeway and Intersection Level

b) Percentage of free flow speeds

c) Average intersection delays
The work zone impacts are present on both levels. In both WZ scenarios, the freeway volumes changed along the whole stretch of the freeway. The reduced capacity and speed within the work zone area cause time-dependent changes in traffic patterns reported by the DTA model. The implementation of VMS further reduces the freeway volumes. The drop in freeway volumes starts at segment 2, which is located at the 3300 S ramp, where vehicles exit the freeway in search for alternate routes. The volumes are lower throughout the entire work zone, and they start to increase after the ramp at 4500 S. Once passed the 5300 S ramp, the volumes in the WZ scenarios return to regular levels, meaning that all the vehicles that used alternate routes returned to the freeway.

The speeds in the base scenario drop significantly at segments 4 and 5, which are the segments after the 3300 S on-ramp. In the WZ scenarios speeds at these segments are much higher, because of the significantly lower volumes after the 3300 S ramp. However, the speeds within the work zone affected area (within and around segment 6) drop significantly in both WZ scenarios. The speeds in the WZ + VMS scenario are slightly higher in the segments following the work zone. The speeds in the three scenarios converge to the same value after the 5300 S ramp. These results can be used to assess the work zone impacts on freeway traffic.

The analysis of delays at signalized intersections through QEM shows the impacts that a freeway work zone has on the adjacent arterial network. Signalized ramps experience the most increase in delays, which is higher in both WZ scenarios. The increase in delays at intersections just east and west of the freeway and along the adjacent arterials is still significant. On average, with QEM optimization for the new volumes, the delays for the 40 intersections were increased about 12% in the WZ scenario. Figure 2 c) also shows significantly higher delays at critical intersections without the QEM optimization, increasing from 30% to almost 500% when compared to the Base scenario. The VMS implementation also has impacts on arterial operations, and the delays are in this case just slightly higher than in the Base scenario. QEM provides detailed information for all signalized intersections, allowing much better assessments of their performance.